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All versions of Clients & Profits have built-in media planning, buying, and tracking
capabilities. These media functions seamlessly integrate with job tickets, job costing,
client billing, and the agency’s financial accounting, depending on which version of
Clients & Profits you use. All versions of Clients & Profits can create detailed broadcast
and print media orders for TV, newspaper, magazine, and alternative media buys, as well
as import media orders from buying systems such as Strata, SmartPlus, and TAPSCAN.
With both Clients & Profits Pro and Clients & Profits Classic feature media billing, the
media planning, reporting, and accounting functions in Clients & Profits Classic are
limited. The back cover of this guide contains a chart that compares the media features
on Clients & Profits Classic, Clients & Profits Pro, and Job Tracker.

This guide explains Clients & Profits’ complete media management capabilities, including
how to:

■  create and maintain lists of stations/programs and publications/ad sizes
■  add, edit, and print broadcast and print media plans
■  add and print media estimates
■  create insertion and broadcast orders automatically from media plans and estimates
■  add and print broadcast orders and insertion orders
■  import media orders from Strata, SmartPlus, and TAPSCAN
■  track materials due and space closing dates
■  print media plans, estimates, and reports

Introduction
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You’ll find many helpful screen shots throughout this guide that illustrate Clients & Profits’ media
features and capabilities. You’ll find up-to-date technical information about how the media interface
works, as well as tips, shortcuts, and troubleshooting ideas at the Clients & Profits media web site:

www.clientsandprofits.com/media/media.html

You’ll also find more information about the C&P Media Link and the Standard Media Interface here:

www.clientsandprofits.com/media/media_link.html



4

How Clients & Profits Manages Media

The media functions in Clients & Profits are designed to replace the
database or spreadsheet-based custom systems that most shops now use to
plan, buy, and track media. It doesn’t try to replace high-volume media
buying systems like SmartPlus, TAPSCAN, or Strata.  Instead, it is designed
for shops that buy a relatively small amount of media—and whose planning
and analytical needs are simple.

Although it can create broadcast buys, Clients & Profits is optimized for
print media planning, buying, and tracking. It works best in shops that
primarly buy business-to-business media, instead of consumer broadcast
media. That’s because it doesn’t import and process ratings data from media
services like Nielsen and Arbitron. Instead, you’ll set up and maintain your
own station, publication, program, ad size, and rate information. (It’s a big
job to maintain these files, so it’s only practical if the number of media
plans you do is small.)

There are two ways to buy media with Clients & Profits: media plans and
media estimates. Media plans (which aren’t available in C&P Classic) are
elaborate and automatically lookup ad rates, while media estimates are
simple and added manually. They both print a professional-looking report
for your client to sign, authorizing your media buys. Otherwise, they have
different purposes.

Media estimates vs. media plans

Media plans use the station and publication data (which you’ll set up) to
automate the planning process—so there’s no rekeying information from
the rate table to the media plan. Media estimates skip the planning
process—instead, you’ll simply type in the details about the media buy
each time you need one. There are also specially-designed media windows
and forms for broadcast and print plans.

Media estimates, however, are free-form. You can customize the information
on media estimates as needed. Every media estimate you do could
conceivably have different labels and headings, depending on the different
kinds of media that you buy. Since there’s less to set-up, creating a media
estimate is much faster than creating a media plan (which may be reason
enough to use them).

If you don’t need a planning system, or use another system (like a
spreadsheet or Tapscan) to plan your buys, consider using only media
estimates. Once the media estimate is added, it can easily create insertion
orders automatically without rekeying. This saves lots of time and effort, as
well as keeps your insertion orders more accurate.

Media and the General Ledger

There is no direct link between media plans and the General Ledger. Adding
a media plan doesn’t affect jobs. The job ticket is updated when an
insertion order is created from a media plan; the job task’s Net and Gross

How Clients & Profits Manages Media

PO total increases to show that you’ve ordered something. Insertion orders,
like purchase orders, don’t affect the General Ledger either. The General
Ledger is only affected when the station or publication’s invoice arrives or
the insertion is billed.

You can account for insertion orders made during the month with general
journal entries to a media G/L account. A list of insertion orders added
during the month can be printed from the PO Reports window; this total
would be added as a journal entry, then reversed next month  The difference
between the month’s insertions is your actual media cost.

Media Estimates

If you buy mostly print media (magazines and newspapers) for your clients
and you’re planning needs are basic, use a media estimate. Adding a media
estimate is similar to adding a job:  the media estimate has a number, a
client, a description, and line items just like a job has tasks. Media
estimates are very customizable. Each media estimate has five column
labels (e.g., publication name, issue date, close date, ad caption, and ad
size) that you can change for different kinds of media buys. You can enter a
long description, a campaign code (for post-buy tracking), a standard
disclaimer, and up to three approval names. These details appear on the
printed media estimate. Media estimates don’t affect job tickets until the
insertion orders are created. They are available in all versions of Clients &
Profits.

Print and Broadcast Media Plans

On the media plan for a client, enter a plan number, name, and other
details, then add separate buys for each station or publication. Print media
plans can be set up for monthly, weekly, or daily publications. For
magazines, these periods can represent months during the year. For
newspapers, they can represent different weeks. Since these periods are
customizable, they can handle any kind of time range; however, the periods
you enter apply to every buy on the media plan.

■  Media plans are only available in Clients & Profits Pro and Job Tracker.

Adding media buys is like adding tasks to jobs. You’ll enter the publication
or station code, which behaves like the task code. You can see the
publication’s ad sizes (or the station’s programs/times) from a pop-up
Lookup List. Double-clicking on an ad size (or program) enters it onto the
media plan. Most importantly, the rate is copied to the media buy
automatically. For broadcast buys, you’ll enter the number of times the spot
will run—and the total cost and rating points are calculated automatically.
You can add many different buys for many different publications (or
stations) onto the same media plan.

When the media plan is printed, the buys you’ve entered are grouped
together by publication (or station).An insertion or broadcast order can be
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Clients & Profits Pro and Job Tracker feature an integrated media calendar. The calendar,
which conveniently appears whenever users work with media, lists upcoming space closing
and material due dates as well as user-defined calendar “tickler” entries. These scheduled
entries can be automatically e-mailed to media planners, buyers, and vendors. Not available
in Clients & Profits Classic.

The names, addresses, and phone numbers of the most commonly-used publications and
their various ad sizes (including prices) can be set up before adding print media plans. The
information entered for each publication and ad size is copied automatically to new print
plans, saving time and reducing data-entry errors. The publications table can be updated any
time as information changes.

Stations table lists the name, address, and account details for hundreds of different radio,
television, and cable stations. The Times/Programs table contains descriptions and costs of
the time slots offered by each station. This information is used automatically by broadcast
media plans, and is copied to broadcast orders. Not available in Clients & Profits Classic.

Simple, quick media estimates can be created for clients showing them a schedule of media
buys for any number of publications or stations. The printed media estimate looks like a job
estimate, and includes a client approval signature line. Insertion orders can be made
automatically from media estimates.

Detailed broadcast media plans can be created that show scheduled radio, television, cable,
or internet buys, including the number of spots, rating, cost per point, and more. Broadcast
orders can be generated directly from broadcast media plans. Not available in Clients &
Profits Classic.

Complete print media plans can be made that show schedule ad placements for daily
newspapers, weekly periodicals, or monthly magazines. Insertion orders can be created from
print media plans without rekeying. Not available in Clients & Profits Classic.

Orders can be created automatically from broadcast and print media plans. Orders can be
placed any time using the information already saved on the media plan, saving time and
eliminating rekeying errors. Orders are saved directly in the Purchase Orders table, where they
can be proofed, printed, then billed—without retyping.

Once insertion and broadcast orders are created from media plans, they can be easily and
quickly billed. Orders can be pre-billed directly from the Purchase Orders window (choose
Edit > Pre-bill) one-by-one, or billed together in batches by client in Accounts Receivable.
Insertion and broadcast orders remember the client’s invoice number, so it’s easy to keep
track of unbilled media.

Media accruals for work in progress are posted automatically from media billing. The net cost
of the insertion or broadcast order is used for accrual journal entries, which update a special
WIP accrual G/L account. When the media vendor’s invoice is entered, it reconciles the
actual cost of the media with the accrued cost then makes the automatic reversing entry. Not
available in Clients & Profits Classic or Job Tracker.

In Accounts Payable, the actual number of broadcast spots or ad placements is reconciled
with the planned spots from the insertion or broadcast order. Each order keeps its own
running balance of planned cost vs. actual cost, making it easy to bill clients accurately.

The optional C&P Media Link imports broadcast orders from MRP’s SmartPlus, TAPSCAN,
and Strata. Imported buys appear automatically in the Purchase Order window, where they
can be billed like other broadcast orders. A “standard media interface” lets any other media
buying system export buys to Clients & Profits using a simple-to-program import file format.

Media Calendar

Publications/Ad Sizes Tables

Stations/Programs Tables

Media Estimates

Broadcast Media Plans

Print Media Plans

Insertion Orders, Broadcast Orders

Media Billing

Media WIP Accounting

Media Reconciliation

Importing SmartPlus, TAPSCAN,
and Strata Media Buys

Media Features

Feature How it works, how it’s used
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easily and quickly pre-billed directly from the Purchase Order window. It’s
simple:  find the order, then choose Pre-bill this Purchase/Insertion Order
from the Edit menu. The order’s details are copied instantly to a special pre-
billing invoice. The invoice is numbered automatically. You can see pre-bill
invoices on the proof list, make any needed changes, then post them. Once
posted, the pre-bill invoice information updates the insertion or broadcast
order so it can’t be billed twice.

It’s also easy to bill many insertion or broadcast orders at once. The media
billing option in Accounts Receivable displays a window listing the client’s
unbilled insertion or broadcast orders. You can select one, many, or all
orders for billing by clicking on the checkbox next to the order line item.
The media billing invoice has a different layout than regular job billings; it
shows the publication or station, ad name, ad size, issue date, and gross
cost.

Media Preferences

Your media preferences let you standardize some of the information seen
on insertion and broadcast orders. This information, such as the disclaimer,
logo, and print copies are copied to orders automatically to save time. You
can even order media under a different name and address, which is ideal for
in-house agencies. You can customize how insertion and broadcast orders
are automatically numbered, including entering the next order number.

Overview (con’t)

Importing Media Buys If your shop buys a lot of broad-
cast media spots, then you’re probably already using
a media buying system such as MRP’s SmartPlus,
Tapscan, and Strata. These systems perform sophis-
ticated planning and analysis for high-dollar media
plans that Clients & Profits doesn’t try to duplicate.
Since these systems also print their own insertion
orders, rather than rekeying these insertions, the C&P
Media Link can instantly import them as broadcast
orders (just as if you’d typed them one by one). The
C&P Media Link works along side the C&P broadcast
plans, print plans, and media estimates. You can still
add and print insertion orders from Clients & Profits.
The Media Link can run unattended, automatically
importing new media orders at selected intervals. Or,
media orders can be imported manually. The Media
Link also keeps a daily log of what’s been imported
for better accountability. For more information, check
the Clients & Profits media web page at:
www.clientsandprofits.com/media.html.

How Clients & Profits Pro Manages Media

Publications, Ad Sizes, and Contract Rates

The Publications/Ad Sizes/Contract Rates window lists the publications you
most commonly use, as well as the various ad sizes available for each
publication. Each publication can have dozens of ad sizes, each with details
about its position, commission, space close, and materials close dates.
These production specifications are carried over to the media plan and to
media reports, for easy reference. Each publication ad size has a standard
rate. In addition, you can set up contract rates for each client. This option
lets you specify special ad sizes and rates that are only available to a
client. So when a print buy is added for a particular publication, the client’s
special rate will be used instead.

Stations, Programs, and Contract Rates

The Stations/Programs/Contract Rates window lists the stations you most
commonly use, as well as the programs/times for each station. You can
enter a virtually unlimited number of stations. And each station can have
hundreds of different programs and times. A station can have a set of
programs, each with its rating and a standard cost. Or, you can set up
contract rates for specific programs and clients. Each client can have its
own table of contract rates for each station. So when a broadcast buy is
added for a particular station, the client’s special contract rate will be used
automatically.

Insertion Orders

Insertion orders can be added manually into the Purchase Order window, or
created automatically from print media plans or media estimates. When
created automatically, there’s no rekeying—the media buy’s publication, ad
name, position, cost, and other details are copied directly to the insertion
order. You can make insertion orders from media plans and estimates on
demand; the entire process takes less than a minute. Once the insertion
order is saved, you can review it, make changes, then print it for the
publication.

Broadcast Orders

Broadcast orders can be added manually into the Purchase Order window, or
created automatically from broadcast media plans. When created automati-
cally, the media buy’s station, rating, number of spots, and other details are
copied directly to the broadcast order. Once the broadcast order is saved,
you can review it, make changes, then print it for the station.

Media Billing

There are two ways to bill media in Clients & Profits Pro: pre-billing an
individual insertion (or broadcast) order or summary billing one or more
orders.
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The Media Flow Chart

TV / RADIO / CABLE /
INTERNET

1.
Add stations, programs, and client

contract rates

2.
Add broadcast media plan

3.
Add media buys for broadcast plan

4.
Print the broadcast media plan for

review

5.
Make revisions, then print the
broadcast media plan for client

approval

6.
Print station’s broadcast worksheet

7.
Make broadcast orders

8.
Pre-bill the broadcast orders

or create a Media billing

MAGAZINES / NEWSPAPERS /
INTERNET

1.
Add publications, ad sizes, and client

contract rates

2.
Add print media plan

3.
Add space buys for print plan

4.
Print the print media plan for review

5.
Make revisions, then print the

print media plan for client approval

6.
Make insertion orders

7.
Pre-bill insertion orders or

create Media billing
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The Media window

The Media Plan Browser

The Media window is an Information Center-like window for managing
media. The window features buttons for using media estimates, broadcast
plans, print plans, and the stations and publications tables.

To open the Media window

1  Choose View > Media Plans (Media Estimates).

The Media Recap gives media planners and buyers a one-stop place to check
upcoming deadlines for space closing and materials due—as well as any
scheduled calendar entries added by other C&P users. Instead of printing a
media traffic report, a media buyer
can use this window to look up
media deadlines for the next four
weeks (one week at  time). Space
closing deadlines are listed from
broadcast and print media plans,
using space closing dates entered for
each media buy. Materials due
deadlines are shown from insertion
orders using dates entered when the
order was created. And media
calendar entries are shown.

Media calendar entries are added by
C&P users as an online “tickler” file
for remembering important media-
related dates, such as client
presentations, vendor meetings,
conferences, and planning sessions.
Media calendar entries can be scheduled
for any time in the future, and have the
option to be automatically e-mailed when
they’re due.

To update the Media Recap

1  Choose a week from the pop-up menu.

2  Click the  (i.e., Lookup) button.

Clients & Profits looks up the week’s schedule entries from the Media
Calendar, space closing deadlines from broadcast plans, and material
deadlines from insertion orders.

■  Double-click on a media calendar entry to see its full details.

To add a media calendar entry

1  Click the  (i.e., Add) button.

2  Enter the scheduled entry’s date, subject, and description.

3  Choose a staff member name from the Notify pop-up menu to automati-
cally e-mail this entry on its date.

4  Click Save.

To edit a media calendar entry

1  Double-click on the entry you wish to
change.

To delete a calendar entry

1  Find the entry you wish to change.

2  Click the  (i.e., Delete) button.

To print the Media Calendar
report

The Media Calendar report shows the
selected week’s calendar entries.

1  Choose a week from the pop-up menu.

2  Click the  (i.e., Print) button.

Media calendar entries keep
track of important media dates.
“Tickler” entries can be scheduled
for any time in the future. They’ll
appear in the Media Calendar list,
and can be automatically e-mailed
on the day they are due.
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The Media window

1  Use the toolbar buttons to update
the calendars, add, edit, and delete
calendar entries.  The Print button
prints a hard-copy of the media recap
boxes, including the week’s calendar
entries.

2  Click the Media Estimates button
to open the Media Estimates window,
where you can add, edit, delete, and
print media estimates.

3  Clicking on the Broadcast Plans
button opens the Broadcast Plans
window, where you can add, edit,
delete, and print radio, TV, cable, and
internet media plans.

4  Click on the Print Plans button to
view, add, edit, delete, and print daily,
weekly, and monthly print media plans.

5  Clicking on the Stations button
opens the Stations/Programs window,
which lists all of the TV, radio, and
cable stations used by broadcast plans.
Dozens of different times/programs
can be added for each station, each
with its own cost, rating, and
description.

6  Click the Publications window to
show all of the newspapers,
magazines, and periodicals used by
print media plans. For each publication
you’ll see its ad sizes, including costs.

7  The Media window can list space
closing, material due, and calendar
entries for the next four weeks by
using the Week menu. Scheduled
entries are shown one week at a time.

8  The space closing list shows
upcoming space deadlines from
broadcast and print media plans. The
space closing date can be entered
separately for each buy on a media
plan.

9  The materials due list shows
upcoming traffic deadlines from actual
insertion and broadcast orders.

10  The 7-day media calendar shows
upcoming media related dates.

p
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Publications

Publications

Clients & Profits Pro keeps a detailed listing of the publications you use for
media print buying.  Each publication belongs to a vendor in the Vendor
table.  One vendor can have dozens of publications, each with its own
collection of various ad sizes and rates.

Publications are used by print media plans.  A print media plan is composed
of different space buys.  Each publication is added as a separate space buy
on a print media plan, along with up to
twelve months (or weeks, or seven
days) of insertions.  When you’re
adding a space buy, you’ll select a
publication from the Publication lookup
list—which links the media buy with
the publication and its rates.

The Publications/Ad Sizes window
shows both your publications and their
ad sizes.  You’ll add, edit, and delete
both publications and ad sizes here.
The window’s toolbar buttons let you
add, edit, delete, and print publications
and ad sizes.  There is no limit to the
number of publications (and ad sizes)
in your Publication table.

To view the Publications table

1  From the Media window click on the
Publications button.

The Publications/Ad Sizes window lets
you add, edit, delete, and print both
publication and ad sizes/rates.

To add a new publication

1  Click the  (i.e., Add Pub) button.

2  Enter the publication’s vendor.

Each publication needs to be associated
with a vendor in the Vendor table. The vendor and the publication can be
the same, but must be added separately. One vendor can have many
publications.

3  Enter the publication code.

The publication code is used for sorting and sub-totaling media buys on
reports and client invoices, so clients will see it. Each publication code

must be unique. It is customizable and user-defined.

4  Enter the publication’s name, address, phone, rep name and address, and
other details, then click Save.

The address, phone, and representative information is optional, but appears
on printed media orders.

To change a publication
1  Click on publication to select it,

then click  (i.e., Edit) or double-

click on a publication.

2  Make your changes, then click Save.

If a publication has ad size records,
its pub code can’t be changed. Editing
a publication’s details does not affect
existing insertion or broadcast orders.

To delete a publication

1  Click on publication to select it.

2  Click  (i.e., Delete).

A publication which has ad size
records can’t be deleted.

To print a publications list

1  Click the Print button.
See publication info at a click
of a mouse.  Anyone using Clients
& Profits can see and update the
publication’s information,
including the ad representative’s
name, address, and phone
number.
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The Publications window

1  Use these toolbar buttons to add,
edit, and delete publications as well as
print a publication list.

2  Use these toolbar buttons to add,
edit, and delete ad sizes and contract
rates for the currently selected
publication.  You can also print a list
of ad sizes/rates by clicking the Print
button.

3  Each publication can have dozens of
ad sizes/rates.  You can set up
standard rates for each ad size, as well
as special size/rate combinations for
each client.  When a print media plan
is created, the right rate will be copied
to the space buy automatically.
Selecting a client from the pop-up
menu displays that client’s special
contract rates.  The ad sizes/rate table
needs to be frequently updated as the
rates and ad sizes change.

4  Your publications are listed here,
sorted alphabetically.  Clicking once on
a publication displays its ad sizes and
standard rates.  Double-clicking on a
publication opens the Publication
window, where you can make changes
to the publication’s information.

5  The ad sizes and standard rates for
the selected publication are listed
here.  Double-clicking on an ad size
opens the Print Ad Size window, where
you can change the ad’s details.

w
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Stations

Stations

Clients & Profits Pro keeps a detailed table of the stations you use for
media broadcast buying.

Each station belongs to a vendor in the Vendor table.  One vendor can have
dozens of stations, each with its own set of programs, times, and contract
rates.

Stations are used by broadcast media
plans.  A broadcast media plan is
composed of different spot buys for
a two-week period.  Each program/
time is added as a separate spot buy
on a broadcast media plan, along
with the number of spots that will
run each day of the flight.  When
you’re adding a spot buy, you’ll
select a station from the Stations
lookup list—which links the media
buy with the station’s programs,
times, and rates.

The Stations window shows both
your stations (television, radio, and
cable) and their programs/times.
You’ll add, edit, and delete both
stations and programs/times here.
The window’s toolbar buttons let you
add, edit, delete, and print this
information.

There is no limit to the number of
stations (and programs/times) in
your Station table.

To add a new station

1  Choose Media Plans (Estimates)
from the View menu.

2  Click the Stations/Programs/
Contract Rates button.

                   

The Stations/Programs/Contract Rates window opens, listing your existing
stations.

Adding new stations. Each station
belongs to a vendor, which helps
integrate media orders with accounts
payable.  One vendor can have dozens
of stations.  And each station can
have dozens of program/contract rate
combinations.

3  Click the Add Station button.

4  Enter the new station’s vendor number, station code, address, and other
details.

5  Click Save.

To change a station

1  Choose Media Plans (Esti-
mates) from the View menu.

2  Click the Stations/Programs/
Contract Rates button.

The Station/Programs/Contract
Rates window opens, listing your
existing stations.

3  Double-click on a station.

The station window opens,
displaying the station’s
information.

4  Make your changes, then click
Save.
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The Stations/Programs window

The Stations/Programs/Contract Rates
window lets you add, edit, delete, and
print both stations and programs/
times.

1  Use the Station toolbar buttons to
add, edit, and delete TV, radio, and
cable stations as well as print a
station list.

2  Use the Time/Program toolbar
buttons to add, edit, and delete
programs, times, and contract rates for
the currently selected station.  You can
also print a list of programs/times by
clicking the Print button.

3  Each station can have dozens of
different programs/times.  You can set
up standard rates for each program or
time slot, as well as special program/
rate combinations for each client.
When a broadcast media plan is

created, the right rate will be copied
to the spot buy automatically.
Selecting a client from the pop-up
menu displays that client’s special
contract rates.  The program/times/
rate table needs to be frequently
updated as the rates and programs
change.

4  Your stations are listed here, sorted
alphabetically.  Clicking once on a
station displays its programs/times
and standard rates.  Double-clicking on
a station ID opens the Stations
window, where you can make changes
to its details.

5  The times/programs and standard
rates for the selected station are listed
here.  Double-clicking a time/program
record opens the Times/Programs/
Contract Rates window, where you can
change the spot’s details.

q w
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Ad Sizes and Contract Rates

Ad Sizes, Contract Rates

Clients & Profits Pro keeps a detailed table of publication ad sizes/contract
rates for media planning and buying. Each publication has its own set of ad
sizes, one for each type of ad that you commonly use.  The ad sizes table is
completely customizable, including how each ad is described.  The
information you’ll enter for ad sizes is copied automatically to space buys
on new print media plans.  This saves time, since there’s no rekeying.  For
flexibility, you can customize ad size and rate details on any print media
plan.

■  Your ad sizes table will need
to be updated constantly to keep
the information accurate and
timely.

To add a standard ad size
for a publication

1  From the Publication/Ad Sizes
window, click once on a publi-
cation to select it.

2  Click the  (i.e., Add Print

Ad Size) button.

The Print Ad Sizes window
opens, displaying the publica-
tion name and client rate basis
(i.e., standard or client-based).

3  Enter a name or short
description of the ad’s size (e.g.,
“Back Cover”).

4  Enter the basic position for this
ad size.  Its position is copied to the
media plan and then to the insertion
order. Position can be customized
on specific plans and insertion orders.

5  Enter the ad size’s notes, which
are used for your own reference. They do not appear on plans or insertion
orders.

6  Enter the ad size’s gross cost (i.e., what the publication charges for the
ad, including your commission), your agency commission (which is
typically 15% or less), and net cost (i.e., the amount you’ll eventually pay
for the ad). The bill net cost, not gross tells the insertion order to exclude
any commission or markup.  Use this option when your clients don’t pay
commissions for media buys.

7  Enter the ad’s standard issue date here.  It is used for quick reference
when planning a buy’s space close and materials due dates.  This informa-
tion doesn’t appear on the printed media plan or insertion order.

8  Enter the ad’s typical space closing date here. It is used as a reference
while you’re scheduling a buy’s production dates.  It doesn’t appear on
printed media plans or insertion orders.

9  Enter the day of the month on
which materials close. This
information appears on the Space
Close/Materials Due Dates pop-up
window when you’re editing a
media buy.

10  Click Save.

To add a special ad size or
rate for a publication and
a client

1  From the Publication/Ad Sizes
window, click once on a publica-
tion to select it.

2  Choose a client from the pop-up
menu.

The pub’s standard rates are now
replaced by the client’s special
contract rates.

■  Choosing a client from the pop-up menu displays the client’s contract
rates and ad sizes for the publication.  Each client can have its own
contract rates that reflect special deals you make with the publication on
the client’s behalf. When a space buy is added to the Print Media Plan, the
client’s special rates will be used automatically, replacing the standard
rates.

3  Click the Add Ad Size button.

4  Enter the ad size’s name, the client’s special ad cost, and other details
like a regular ad size.

5  Click Save.

On-line ad sizes make media
buying more accurate. Media buyers
can set up many ad size records for
each publication. The details entered
for each ad size is copied automati-
cally to print media plans, then
finally to insertion orders.
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Times, Programs, and
Contract Rates

Clients & Profits Pro keeps a detailed list of times, programs, and contract
rates for broadcast media planning and buying. Each station has its own set
of times and programs, one for each type of spot that you commonly use.
The Times/Programs table is completely customizable, including the name
of each spot (e.g., “Late Show”), its rating, cost, and a description.  The
information you’ll enter for programs and times is copied automatically to
spot buys on new broadcast media plans.  This saves time, since there’s no
rekeying.  For flexibility, you can
customize programs/times and
rate details on any broadcast
media plan.

■  Your Time/Program/Contract
Rates table will need to be
updated constantly to keep the
information accurate and timely.

To add a program/time
record for a station

1  From the Stations/Programs/
Contract Rates window, click
once on a station to select it.

2  Click the  (i.e., Add

Time/Program) button.

The station’s Time/Program
window opens, displaying the
station name and client rate
basis (i.e., standard or client-
based).

3  Enter the time/program name to
describe the daypart or program. This
name appears on the printed broadcast
media plan and worksheet, so
clients see it.

4  Enter the time/program’s rating.

5  Enter the time/program’s gross cost (i.e., what the station charges for
the spot, including your commission). The rating and gross cost are copied
to the broadcast media plan automatically.

6  Enter a long description to note any kind of additional information
about the time/program. This description is for internal use and doesn’t
appear on the broadcast media plan.

7  Click Save.

To add a special program or contract rate for a station and
a client

1  From the Stations window, click once on a station to select it.

2  Choose a client from the pop-up menu.

The station’s standard rates
are now replaced by the
client’s special contract
rates.

■  Choosing a client from
the pop-up menu displays
the client’s contract rates
and time/programs for the
station.  Each client can
have its own contract rates
that reflect special deals you
make with the station on the
client’s behalf. When a spot
is added to the Broadcast
Media Plan, the client’s
special rates will be used
automatically, replacing the
standard rates.

3  Click the Add Time/
Program button.

4  Enter time/program’s
remaining details.

5  Click Save.

Programs, times, and rates.
A station can have dozens of
different time/program records. The
details entered for each time or
program is copied automatically to
broadcast plans, then finally to its
orders.
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Media Estimates

The media estimate provides a simple way to show clients how and where
their ads will be placed.  The estimate is composed of different media buys
made for a single campaign, such as a product launch.  The media estimate
features a long description that can be used to describe your objective for
these buys; this description appears on the printed estimate that the client
approves.  There’s no limit to the number of media estimates you can create
for a client.

A media estimate can contain one
or more media buys.  Each media
buy appears separately as a line
item on the printed media estimate.
The media buy is customizable; you
can enter custom headings for each
of the buy’s five fields.  Since the
media estimate is designed
primarily for print media, the
standard column labels are:
publication, issue date, close date,
ad number or caption, and ad size.
The gross amount for each buy—
what the client will eventually
pay—appears on the printed
estimate.

Unlike media plans, the media
estimate does not use the publication ad sizes lookup table.  This means
you’ll need to enter the media buy’s issue date, close date, etc. separately
on each media estimate.  However, the publication field will automatically
look up and show your publication table; double-clicking on a publication
enters it onto the estimate.

Insertion orders can be created automatically from media estimates.  You
can easily make a separate insertion order for each buy, or combine some or
all buys on a single insertion.  The media estimate tracks when each buy
was ordered, for better accountability.  Each media estimate features a
user-defined status.  A status report can be printed anytime showing media
estimates sorted by status.

To see media estimates

1  From the Media window, click on the Media Estimates button.

The Media Estimates window opens, showing the last-added media estimate.
Toolbar buttons along the top of the window let you find, add, change, and
print media estimates.  Double-clicking on a line item displays the
estimate’s buy details, which you can change.

To find a media estimate

1  Click the  (i.e., Find)

button.

2  Enter the media estimate
number, or choose a different
find option from the Find By
pop-up menu.

You can find media estimates by
estimate number, client, or
sequence (i.e., the order in
which they were added).  To find
a media estimate for a selected
client:  Click the Find button,
then choose Client from the pop-
up menu.  Enter the client
number, then click Find.  The
first media estimate for the

chosen client appears.

3 Click Find.

■ Click the Next or Previous button to browse through other media
estimates.
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The Media Estimate window

1  Use these buttons to find a media
estimate, or browse forward or
backward.

2  Use these buttons to add, edit, or
delete the entire media estimate.

3  Use these buttons to add and
remove selected media buys and to
print the media estimate.

4  Click the Make Insertion button to
create insertion orders for one or more
buys on this media estimate.

5  The media estimate’s client, date,
description, and buyer appear for
reference.

6  Every estimate has a customizable
estimate number.  It works like a job
number to identify different media
estimates.  New media estimates are
numbered automatically.

7  A media estimate can be marked as
closed after its buys have been
ordered. Placing a media estimate on-
hold makes it inactive, but keeps it
open for future use. Closed and on-
hold orders don’t appear on media
status lists and traffic reports.

9  A media estimate can contain
dozens of individual buys, which
represent different months in which an
ad will run. The column headings for
media buys are customizable—each
media estimate can have different
labels, for flexibility. They can be
changed by clicking the Edit button.

10  The status field can be used to
track media estimates. It appears here
for reference, but it can be edited in
the Edit Media Estimates window.
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Adding a Media Estimate

Adding a Media Estimate

Anyone who can access media plans can add media estimates.  A media
estimate is added in two parts, much like adding a job ticket.  First, open
the new media estimate, which includes the estimate number, client,
campaign name, and description.  Next, add media buys for each time an ad
will run for this estimate.

Media estimates are flexible, so can be changed as needed.  You can change
any part of the media estimate’s client number, description, status,
disclaimer, and approvals (but not the estimate number) any time.  Media
buys can be added, changed, and removed as well.

To add a media estimate

1  From the Media window, click the Media Estimates button.

2  Click the Add button.

3  Enter a client number.

Each media estimate is opened for only one client.  This would be the client
who will be responsible for authorizing these media buys.

■  If you don’t know the client number, leave it blank then press Tab.  The
client lookup list opens, displaying your clients.  Double-clicking on a client
name enters it into the new media estimate automatically.

4  Enter the estimate number, status, and campaign.

Media estimates are numbered automatically, based on a client number.
When you tab past the client number, the estimate number is calculated
automatically from the client’s media estimate number.  Each client has a
media estimate number—see the client’s Billing Information window—
which is customizable.  (By the way, media estimates and media plans are
numbered separately.)  The standard estimate number combines the client
code and the next media estimate number.  You can change it by entering
your own number over the automatic one.

Each media estimate can have a customizable status description.  Status is
used to track media estimates from start to finish, and is optional.  There is
no lookup table for the media status—just enter any text that’s helpful.
Later, you can print a report showing media estimates arranged by status.

The media campaign name is optional, too.  It is there as a convenience to
your client, since it appears on the printed media estimate.  Different media
estimates can belong to the same campaign.  Custom reports can be created
showing media estimates and media buys by campaign, if needed.

5  Enter the job and task.

The media estimate’s job and task will be copied to the estimate’s insertion

orders.

6  Enter the description.

The complete description appears on the printed media estimate.  Use it to
describe the estimate’s strategy or objective to the client.  Since the media
buys don’t have much room for descriptions, any additional information or
special instructions should be included here.

■  If you don’t want the description to appear on the media estimate, de-
select the “show description on printed media estimate” checkbox.

7  Enter the column labels.

The media estimate’s column labels determine what kind of information
appears for its media buys.  The standard labels are designed for print
media:  publication, issue date, close date, ad number/caption, and ad size.
You can enter any kind of text in these labels.  When you add media buys to
this estimate, you’ll see these column labels.  Each media estimate can
have its own special set of column headings.  The headings you enter here
won’t affect other media estimates.

8  Enter the media estimate’s approval names.

Each media estimate can include up to three approval names.  Anyone can
be added as an approval name, such as a client contact, media buyer,
account executive, etc.  There are no standard approval names.

9  Enter the disclaimer.

The disclaimer appears at the bottom of the printed media estimate, above
the approval names.

There is no standard disclaimer.  (The default disclaimer in Preferences is
only copied to insertion orders, not media plans or media estimates.)

10  Enter the commission percentage.

The commission percentage will be copied from the client file, but can be
changed here.

11  Click Save.

To clone a media estimate

Cloning creates a new media estimate from an existing one. It copies all of
the details and buys from an existing media estimate, then lets you change
it. To clone a media estimate, choose Edit > Clone Media Estimate. Enter the
new media estimate’s additional details, then click Save.
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The Add Media Estimate window

1  Each media estimate is opened for
only one client. Media estimates are
numbered automatically by client, like
job tickets. The estimate number is
the combination of the client number
and its next estimate number. You can
enter any kind of estimate number you
like.

2  Media estimates can be tracked by
status on reports. The status is
optional, and is completely
customizable. It is not related to the
job production/billing status codes.

3  Media estimates can contain client
campaign codes. These optional codes
can be used to track media expenses
by campaign.

4  Media estimates don’t directly affect
job tickets until insertion orders are
created. A media estimate’s insertion
order gets its job number and task

from these fields. All buys on the
media estimate use the same job and
task.

5  The description can contain any
kind of notes, specifications, objec-
tives, or strategies that should appear
on the printed media estimate. You
can show or hide the description on
printed media estimates by selecting
the show description option.

6  These are the initials of the person
who adds the media estimate, typically
the media buyer.

7  The estimate’s column labels are
important, since they determine the
content of the media estimate. The
standard labels are set up for typical
print media buys, but they can be
changed. These labels will be used by
every buy on this estimate. Changing
labels on one media estimate doesn’t

affect other estimates. There is no way
to change the standard label settings.

8  The disclaimer appears at the
bottom of the printed media estimate,
above the approval names. It is
complete customizable. The disclaimer
you’ll enter here doesn’t appear on
other media estimates.

9  Up to three approval names can
appear on the printed media estimate.

10  The media commission is used to
calculate each buy’s net cost from its
gross cost, which is entered by the
media buyer.
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Adding Buys to a Media Estimate

Adding a Buy to a Media Estimate

The media estimate is incomplete without media buys. The buys indicate
exactly which ads are running on each publication. A single media estimate
can contain media buys for many different publications, or many buys for
the same publication. Each media buy features descriptive fields that are
defined by the media estimate (the standard fields are publication, issue
date, close date, ad number/caption, ad size, and gross cost).

Media buys on estimates use the
Publications table, so you don’t
need to re-enter the publication
name. However, you can also
enter new or one-time publica-
tions that aren’t in the
Publication list. Buys on media
estimates do not use the ad sizes
lookup table—you’ll need to
enter the gross amount, close
date, and space closing date by
yourself on each buy.

You can add, change, and remove
media buys at any time—just like
tasks can be added, edited, and
removed from jobs. Once you’ve
added all of the estimate’s
planned buys, it can be printed for the client’s approval.

To add buys to a media estimate

1  From the Media Estimates window, click the  (i.e., Add Buys)

button.

The Add Buys to Media Estimate window opens, listing the estimate’s
existing media buys. Additional media buys are added one-at-a-time.

2  Enter the publication code.

You can use the Publication lookup list or enter any publication code
(which may be the same as the name). To open the lookup list, leave the
publication field empty then press Tab. The Publication lookup window
opens, listing your publications. Double-clicking on a publication will enter
it onto this media buy.  If the publication is new, a one-time pub, or not on
the Publication lookup list, simply enter its name here.

3  Enter the buy’s issue date.

The issue date appears on the printed media estimate, insertion order, and
the client’s media invoice. The issue date field can contain any kind of
information.

4  Enter the ad’s close date.

The close date also appears on the printed media estimate and insertion
order.

5  Enter the ad number/caption.

The ad number/caption identifies the advertisement on the insertion order.
It is used as a reference by the publication, and can be the code or name

the client uses to track the ad’s
results. The ad caption is usually some
version of its headline.

The ad number/caption is entirely
user-defined, so you can enter
anything here.

6  Enter the ad size.

Ad size describes the ad’s dimensions.
This field is user-defined, so you can
enter the ad’s mechanical size, the
publication unit of measure, or some
other kind of description here.

The ad size appears on the printed
media estimate, insertion order, and
the client’s media invoice.

7  Click on the Notecard button to enter the buy’s position.

The pop-up Notecard window contains space to describe the ad’s position,
specifications, or special instructions—anything you want to appear on the
insertion order. These notes are optional, so can be left blank.

These notes can also be easily edited later by double-clicking on the media
buy.

8  Enter the ad’s gross cost, then press Tab.

The gross cost is the amount the client will eventually pay for the ad,
including your media commission. It appears on the printed insertion order
and client media invoice. Since the media estimate isn’t linked to the
Publication/Ad Size table, the ad’s gross amount isn’t entered automati-
cally. Tabbing past the gross amount field saves the media buy.  Note:  The
buy isn’t saved unless you press Tab here or you can also click Save to add
this new media buy.

9  Repeat these steps to add additional media buys to this estimate, then
click Save.

Once the media buy is saved, you can enter additional buys one after
another.
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The Add Buys to Media Estimates window

1  Enter the publication code here.
To see the Publication lookup list,
leave it blank then press Tab. The
lookup window opens, listing your
publication table. Double-click on a
publication to copy it to the media
buy.

2  The issue date indicates when the
ad will run (such as the magazine’s
month, a newspaper’s day, or some
other date).

3  The close date is the publication’s
deadline to place a space order. If the
client doesn’t approve the media buy
by the close date, it may lose its
chance to run the ad in that issue.

4  The ad number/caption identifies
the advertisement on the insertion
order. It is used as a reference by the
publication, and can be the code or
name the client uses to track the ad’s

on the media buy is used for printing
media spending and other analysis
reports. The media estimate itself does
not affect the General Ledger.

8  The ad’s position, specifications, or
special instructions can be entered
here by clicking on the Notecard
button. You can also enter these notes
later after the buy is saved.

9  Click Save to save a media buy or to
add another buy simply tab past the
Gross Amount field. Click Done to
close this window.

results. The caption is typically
something close to the ad’s headline.

5  Ad size describes the ad’s dimen-
sions. This field is user-defined, so you
can enter the ad’s mechanical size, the
publication unit of measure, or some
other kind of description here.

6  The gross cost is the amount that
the client will be billed for the ad,
including your commission and any
service charge. The ad’s net cost is
calculated automatically using the
media estimate’s commission amount
(which is entered when the media
estimate is first added).

7  The accounting period determines
which month’s financial statement
should reflect the media buy’s cost and
billing. It’s optional, but will make
your media reports more meaningful.
That’s because the accounting period
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Editing Space Buys.  Double-
clicking on a space buy displays
its details, including when the buy
was ordered. The buy’s insertion
order number, date, and amount is
shown for easy reference.

To edit a space buy on a media estimate

The Edit Media Estimate Space Buy window opens, showing the buy’s
publication, issue and close date, gross amount, and other details.

1  Find the media estimate you wish to change.

2  Double-click on a media buy to
change it.

The buy’s column labels (i.e.,
publication, issue date, etc.) can’t
be changed here. Since these labels
apply to every buy on a media
estimate, they don’t vary from buy
to buy. To change these labels, edit
the media estimate’s description.
Note: Changing these labels affects
all buys on the media estimate.

The accounting period is used by
media analysis reports, but has no
affect on the General Ledger.

If the media buy has already been
ordered on an insertion order, you’ll
see the IO number, date, and actual
order amount at the bottom of the window.

To remove a space buy on a
media estimate

A space buy can be removed from a
media estimate anytime before it is
ordered (that is, if an insertion order
is created for it).  Removing a buy is
permanent.  If a space buy is removed by mistake, you’ll need to re-enter it.

1  Click once on a media buy to select it.

2  Click the  (i.e., Remove Buy) button.

3  Click Yes when prompted.

To edit or delete a media estimate

A media estimate can be edited anytime.  To edit a media estimate’s name/
title, description, and other details, click the Edit button.  When the Edit
Media Estimate window opens, make your changes then click Save.

1  Find the media estimate you wish to change.

2  Click on the  (i.e, .Edit Estimate button).

3  Make your changes, then click Save.

A media estimate can be deleted anytime until any part of it has been
ordered (that is, if an insertion
order is created from it).

1  Find the media estimate you
wish to delete.

2  Click on the  (i.e., Delete

Estimate) button.

To print a media estimate

A media estimate can be printed
any number of times until it is
perfect.  (However, a media
estimates can’t be printed unless it
has at least one space buy.)

1  Find the media estimate you
wish to print.

2  Click the  (i.e., Print) button.

Working With Media Estimates
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Making Insertion Orders From
Media Estimates

The option to include media buys on the same insertion order only works if
they have the same publication.  Otherwise, you’ll get different publications
on the same insertion order—which will confuse everyone.

1  Click on the  (i.e., Make Insertion) button.

2  Select an option
to make one buy or
all un-ordered media
buys.

If you’re making an
insertion for a single
space buy, select the
issue date from the
pop-up menu.

3  Click OK.

The insertion order is
created automatically
using details from
your space buy.  You
can make an
insertion order for
one selected space
buy, or for all space
buys on the estimate.
A space buy can’t be
ordered twice; if you
try to select it again,
you’ll see a warning
message.

■  After a few seconds, the insertion
orders are saved.  Once saved, they can
be printed from the Purchase/Insertion
Order window.

Making insertion orders.  Clicking
on a media buy selects it for this
insertion order. An insertion order
can contain a single media buy, or
combine several media buys
together for the same publication.
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Print Media Plans

Print plans can be created for many kinds of newspaper, magazine,
periodical, or Internet-based media buys.  A print plan is similar to a job
ticket:  it is opened for one client, has a number to track it, can be
changed many times as needed, and printed for a client’s approval.

A print plan is made up of one or more media buys.  A media space buy is
made for each publication that is part of the print plan.  A print media plan
can contain dozens of space
buys.  Each space buy features
up to twelve different insertions
for each month of the year.

The print media plan window
shows the plan’s number, client,
title, budget, and space buys.
For each space buy you’ll see its
publication code, publication
name, ad/caption, gross cost,
and the amount that’s been
ordered so far.

To find a print media
plan

1  From the Media window click
on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Click the  (i.e., Find) button.

3  Enter the print media plan number, or choose a different find option
from the Find By pop-up menu.

You can find print media plans by number, client, title, campaign, start
date, or sequence (i.e., the order in which they were added).  To find a
print plan for a selected client:  Click the Find button, then choose Client
from the pop-up menu.  Enter the client number, then click Find.  The first
print plan for the chosen client appears.

4  Click Find.

■  Click the Next or Previous button to browse through other print media
plans.

To work with a print media plan

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Find the print media plan you wish to use.

The Print Media Plan window shows the plan’s space buys.  From this
window use the toolbar buttons to edit, delete, and print this print plan.
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The Print Media Plan window

6  Print media plans are opened for a
single client, just like a job ticket.
The client number will be copied from
the media plan to insertion orders and,
eventually, to media invoices.

7  The media plan’s name/title
appears here for reference.

8   The campaign code is displayed
here for easy reference.

9  The media plan’s optional budget, if
entered, appears here.

10  The media plan’s space buys are
listed by publication.  Each space buy
contains a publication, the name of
the ad being placed, the spot’s gross
cost, and the amount ordered on
insertions so far.  Double-clicking on a
space buy displays its complete
details, including the months in which
the ads will run.

1  Use the window’s find, next, and
previous buttons to locate or browse
through media plans.

2  The window’s toolbar buttons let
you add, edit, change periods,
delete, and print a media plan.

3  Use these buttons to add and
remove space buys to this print media
plan. To edit a space buy, double-click
on publication in the list.

4  The make insertion button creates
insertion orders automatically from a
selected space buy.

5  Each print media plan is tracked by
a media plan number.  Media plans
are numbered automatically by client.
Each client has its own numbering
sequence for easy tracking.  A media
plan’s number can’t be changed.
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Adding a Print Media Plan

Print media plans are added like job tickets:  first you’ll enter the new
plan’s client, number, name/title, and description, then add the plan’s
space buys.

Each print media plan is identified with a plan number.  New print plans are
numbered automatically by client, but can be changed.  You can enter a
name/title for the print media plan, as well as a long description.  Both
fields appear on printed media plans (so clients see this information).  The
print media plan contains date fields (for date started and date ended), an
optional campaign code, and a budget amount.  The budget amount is for
reference only, and can be ignored; it has no affect on job costing.  A print
media plan contains one job and task.  They are copied automatically to the
plan’s insertion orders, and can be changed.

Print media plans can be created for three kinds of periods: daily (for
newspapers), weekly (for newspapers, journals, and other weekly periodi-
cals), and monthly (for magazines). Daily print media plans let you plan
buys for a single seven-day period. Weekly print media plans let you buy
space for any 12-week period. Monthly print media plans let you place ads
for up to 12 months.

A print media plan has six optional user-defined fields.  These fields are
customizable, so can contain any kind of information that isn’t already in
the plan’s description.  You can show these fields on custom reports for
better media tracking.

Most of the information entered on a print media plan is included on the
printed plan that the client will approve.  A print media plan can be revised
then reprinted any number of times.

To add a new print media plan

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Click the  (i.e., Add New Media Plan) button, or choose Add New

Print Plan from the Edit menu.

The Add Print Media Plan window opens, prompting you to enter the new
plan’s client.

3  Enter a client number, or press Tab to open the Clients lookup list.

4  Enter the print media plan’s number, or press Tab to keep the automati-
cally-created number.

New print media plans are automatically numbered by client. The automatic
number includes the client number, the next plan number, and a code
indicating the plan’s kind (i.e., “B” for broadcast and “P” for print). The
client’s media plan number will be incremented when the plan is saved.

5  Choose the print media plan’s kind (i.e., daily, weekly, or monthly).

6  Enter the print media plan’s name/title, start date, end date, budget
amount, campaign, and AE/team.

The name/title should briefly describe the plan’s objective. It appears on
the printed media plan, so the client will see it. The start and due dates are
used by media reports. The plan’s budget amount, campaign, and AE/team
appear on the printed media plan for reference, but are optional.

7  Enter a job number and task for this print media plan.

A print media plan is opened for one job and task. The media plans
themselves don’t affect job tickets; instead, only the insertions generated
from the media plans update a job and task. All insertion orders created
from a plan get the same job number and task. If a default media job and
task is entered in the client window, it is copied here.

8  Enter the print media plan’s description.

This description can explain in detail the media plan’s target market,
demographic, scope, or any other kind of information you’d want the client
to see on the printed media plan. It does not appear on the plan’s insertion
orders.

9  Enter the plan’s user-defined fields.

The six user-defined fields can be used to store specialized information
about a print media plan that otherwise has no place. These fields don’t
affect job tickets or even the plan’s insertion orders. Instead, they only
appear on the printed media plan and on custom reports you create with
them.

10  Enter the print media plan’s approval names.

The names of the people required to approve a print plan should be entered
here, whether they are inside or outside the agency.

11  Click Save.
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The Add Print Media Plan window

1  Every media plan is opened for one
client.

2  Every media plan has a unique
number. They are numbered automa-
tically by client, but can be
customized. The media plan number is
a combination of the client account
number and its special media plan
number.

3  Print media plans can be created for
three kinds of periods: daily (for
newspapers), weekly (for weekly
newspapers, trade journals, and weekly
periodicals), and monthly (for
magazines). Daily print media plans let
you plan buys for a single seven-day
period. Weekly print media plans let
you buy space for any 12-week period.
Monthly print media plans let you
place ads for up to 12 months.

4  The name/title is a brief
description of the plan’s objective,

market, or product. It appears on the
printed media plan, so clients see it.

5  Date started and date ended note
when a plan was opened and closed.

6  Enter the optional budget amount
as the expected total of the media
plan’s space buys.

7  An optional campaign and brand
name can be used by custom reports
to analyze media buys by client.

8  Print media plans can be given an
optional AE/Team name. Media plans
can be analyzed on custom reports by
AE/team.

9  Print media plans don’t directly
affect job tickets until insertion orders
are created. A print plan’s insertion
orders get their job number and task
from these fields. All orders created
from this print media plan use the

same job and task.

10  This long description explains the
plan’s objectives, specifications, or
other important information.  This
description appears on the printed
media plan, but not on insertion
orders.

11  Each print media plan contains six
user-defined fields.  Use these fields
to capture key details about the media
plan that isn’t included in the
description.  These optional fields can
be printed on custom reports.

12  Up to three approval names can
appear at the bottom of the printed
media plan.

13  An optional status can be used to
track media plans from start to finish
using the same Status Table as jobs.
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Adding Buys to a Print Media Plan

Adding Buys to a Print Media Plan

The print media plan is incomplete without buys for ad space. Space buys
indicate exactly which ads are running on each publication during each of
plan’s twelve months, weeks, etc. One print media plan can contain space
buys for dozens of different publications, or many buys for the same
publication.  Each space buy features customizable fields that are defined
by the media buyer, but typically include a position, size, and description.

■  The Add Space Buy window
changes depending on the plan’s
kind—daily, weekly, or monthly.
Regardless of the plan’s kind, all
space buys appear on media reports
together. The media plan’s periods
(i.e., months of the year, days in the
week, etc.) are defined when the plan
is added, so can’t be changed when
adding space buys. Also, different
periods can’t be mixed on the same
print plan (i.e., weekly ads together
with monthly ads).

Space buys on print media plans use
the Publications table, so you don’t
need to reenter the publication name.
(If you don’t know the name of the
publication, the lookup list opens automatically.)  Ad size and cost
information is copied from the Ad Sizes lookup table, and can be changed
on a specific media buy.

The first line of each schedule interval tracks the ad size.  If the ad size is
found in the Ad Sizes table, its cost is copied to the space buy.  If the ad
size doesn’t match, you’ll need to enter the cost, position, and other details
manually.  To see a list of the pub’s ad sizes, click the Lookup Ads button to
open the lookup list; double-clicking on an ad size copies it to the space
buy.

Each space buy also contains the space closing and materials due dates.
This information, as well as the space buy’s position, description, and cost,
is copied to insertion orders automatically.  Eventually, the buy’s details
appear on the client’s media invoice.

You can add, change, and remove space buys from a print media plan any
time—just like tasks can be added, edited, and removed from jobs.  Once
you’ve added all of the media plan’s space buys, it can be printed for the
client’s approval—and the insertion orders created automatically.

To add a space buy

1  From the Print Media Plans window, find a print media plan.

2  Click the  (i.e., Add Space Buy button) or choose Add Time/Space

Buy from the Edit menu.

The Add Space Buy window opens, prompting you to enter the space buy’s
publication and ad schedule.

3  Enter the space buy’s publication code, then press Tab.

If you don’t know the publication code,
leave it blank then press Tab to open the
Publications lookup list.  Double-click on
a publication code to copy it to this
space buy.  You can also add a new
publication from the Lookup window by
clicking the Add button.

4  Enter the ad code/caption and rate
basis.

Both fields appear on the printed media
plan for the client’s information, and
don’t affect the ad’s actual cost, the job
ticket, or the insertion order.

5  Enter the first month’s ad by tabbing
into the top line of a period, then
clicking on the Ads button.

The Ad Sizes lookup list opens, showing the publication’s ads. Double-
clicking on an ad copies it to the space buy’s selected period. Tabbing past
the ad size displays the ad’s gross amount and description from the Ad
Sizes table. If no ad sizes have been set up for this publication, any kind of
information can be entered into these fields instead.

6  Enter the ad sizes, etc. for the remaining months that the ad will run,
then click Save.

To edit the space buy’s important dates

1  Enter the publication, ad/caption, and some ad sizes for the space buy.

2  Click the Edit Dates button.

The Space Close/Materials Due window opens, showing the publications’s
important dates.

3  Enter the appropriate dates for each ad’s space closing and when
materials are due.  These dates will appear on the insertion order.

4  Click Save.

These changes aren’t saved until the plan’s space buy is saved.
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The Add Monthly Space Buy window

1  A separate space buy is added for
each publication. If you don’t know
the publication name, leave the field
blank then press Tab. The publication
Lookup window opens. Double-click on
a publication to copy it to the space
buy.

2  The ad number/caption identifies
the ad on the printed media plan,
insertion orders, and media invoices.
Any kind of description text or ID code
can be used.

3  The rate basis field is for reference
only, and doesn’t affect the ad’s cost.
It appears for the client’s information
on the printed media plan.

4  The Edit Dates button lets you
schedule the ad’s space closing and
materials due dates for the year (or

week, depending on the plan’s
schedule).

5  You can schedule ads to run in the
same publication in any of the twelve
months. Each month contains three
customizable fields plus the ad’s cost.
The first line contains the ad size. The
second line contains the ad’s position,
or some kind of special placement.
The third line contains an additional
caption or description of the ad.

6  Click the lookup ads button to see
the publication’s ad sizes. This lookup
window opens only if you’ve selected
the first line for each month.

7  The ad’s gross cost (i.e., the amount
the client will pay, including your
commission) is entered here. The ad’s
net cost will be calculated using the
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gross cost and the plan’s media
commission.

8  The optional buy notes are user-
defined, but apply to all ads running
for the space buy. Since buy notes
appear on the printed insertion order
(they’re combined with the position
information), they can contain special
instructions for the publication.
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The Add Daily Space Buy window

1  A separate space buy is added for
each publication. If you don’t know
the publication name, leave the field
blank then press Tab.  The publication
Lookup window opens. Double-click on
a publication to copy it to the space
buy.

2  The ad number/caption identifies
the ad on the printed media plan,
insertion orders, and media invoices.
Any kind of description text or ID code
can be used.

3  The rate basis field is for reference
only, and doesn’t affect the ad’s cost.
It appears on the printed media plan.

4  The Edit Dates button lets you
schedule the ad’s space closing and
materials due dates for the year (or
week, depending on the plan’s
schedule).

5  You can schedule ads to run in the
same publication in any of the seven
days. Each day contains three
customizable fields plus the ad’s cost.
The first line contains the ad size.  The
second line contains the ad’s position,
or some kind of special placement.
The third line contains an additional
caption or description of the ad.

6  Click the lookup ads button to see
the publication’s ad sizes.  This lookup
window opens only if you’ve selected
the first line for each month.

7  The ad’s gross costs (i.e., the
amount the client will pay, including
your commission) is entered here. The
ad’s net cost will be calculated using
the gross cost and the plan’s media
commission.

8  The daily schedule can automati-
cally be repeated for a set number of
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weeks. The starting week and the
number of repeated schedules are
choosen by you.

9  The optional buy notes are user-
defined, but apply to all ads running
for the space buy. Since buy notes
appear on the printed insertion order
(they’re combined with the position
information), they can contain special
instructions for the publication.
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The Add Weekly Space Buy window

1  A separate space buy is added for
each publication.  If you don’t know
the publication name, leave the field
blank then press Tab.  The publication
Lookup window opens.  Double-click
on a publication to copy it to the
space buy.

2  The ad number/caption identifies
the ad on the printed media plan,
insertion orders, and media invoices.
Any kind of description text or ID code
can be used.

3  The rate basis field is for reference
only, and doesn’t affect the ad’s cost.
It appears on the printed media plan.

4  The Edit Dates button lets you
schedule the ad’s space closing and
materials due dates for the year (or
week, depending on the plan’s
schedule).

5  You can schedule ads to run in the
same publication in any of the twelve
weeks.  Each week contains three
customizable fields plus the ad’s cost.
The first line contains the ad size.  The
second line contains the ad’s position,
or some kind of special placement.
The third line contains an additional
caption or description of the ad.

6  Click the lookup ads button to see
the publication’s ad sizes.  This lookup
window opens only if you’ve selected
the first line for each month.

7  The ad’s gross cost (i.e., the amount
the client will pay, including your
commission) is entered here. The ad’s
net cost will be calculated using the
gross cost and the plan’s media
commission.

8  The optional buy notes are user-
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defined, but apply to all ads running
for the space buy.  Since buy notes
appear on the printed insertion order
(they’re combined with the position
information), they can contain special
instructions for the publication.
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To edit a print media plan

Everything about a print media plan can be edited, except for the client
number and the media plan number.

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens,
listing the last-added print media plan.

2  Find the print plan you wish to
change.

3  Click the  (i.e., Edit) button.

The Edit Print Media Plan window opens,
displaying the plan’s number, name,
description, schedule, and other details.

4  Make your changes.

For flexibility, you can change the print
media plan’s schedule—the weeks or
months during which the ads will run.  But the changes you make will
affect existing space buys, which may be undesirable.  If you’ve already
made insertion orders for the plan’s buys, do not change the schedule.

5  Click Save.

To delete a print media plan

A print media plan can be deleted anytime before insertions are created.
Once you’ve ordered space for the media plan, it can’t be deleted (unless
you delete the insertion order first).

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Find the print plan you wish to delete.

3  Click the  (i.e., Delete) button.

To print a print media plan

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Find the print plan you wish to
print.

3   Click the  (i.e., Print)

button.

To change a buy on a print
media plan

1  From the Media window click
on the Print Plans button.

The Print Media Plans window
opens, listing the last-added print
media plan.

2  Find the print plan you wish to
change.

3  Double-click once on a space
buy.  Or, click once on a space buy to select it then click the Edit Buy
button.

4  Make your changes, then click Save.

Space buys on a print media plan can be deleted anytime before insertions
are added.  Once you’ve ordered space for the media buy, it can’t be deleted
(unless you delete the insertion order first).

To delete a buy from a print media plan

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Find the print plan you wish to change.

3  Click once on a space buy to select it.

Working with Print Media Plans
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4  Click the  (i.e., Remove) button.

To change a print media plan’s schedule periods

1  From the Media window click on the Print Plans button.

The Print Media Plans
window opens, listing the
last-added print media plan.

2  Find the print plan you
wish to change.

3  Click the  (i.e., Edit
media plan’s periods)
button.

The current schedule periods
will appear.

4  Make your changes, then
click Save.

Editing the periods affects
all buys on this media plan.

To edit a print media
plan’s space closing
and
material due dates

1  From the Media window, click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Find the print plan you wish to change.

3  Double-click on a space-buy.

4  Click on the Edit Dates button.

5  Make your changes, then click Save.
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Making Insertion Orders from
Print Media Plans

Insertion orders can be created automatically from print media plans and
media estimates.  This option can save hours of data-entry time, since
there’s nothing to reenter.  Instead, the information from the media plan—
the publication, issue date, ad#/caption, position, cost, and dates—are
copied directly to new insertion orders.

Creating automatic insertion orders is easy:  find the media plan or
estimate, select the space buy, then click the Make Insertion button.  A list
of the print media plan’s buys will be listed.  Marking the check box next to
a buy will include it on the insertion order.  You’ll have the option to create
one insertion for each buy, or a single insertion order that shows all
unordered media buys.  Use this option, for example, to create an insertion
order for the year’s ads for one publication.

Automatic insertion orders use the same media preferences as manually
added insertion orders.  That is, they’re numbered in the same order and
have the same settings (such as the disclaimer).

Once the new insertion order is saved, it can be reviewed, edited, and
printed from Purchase/Insertion Orders.  In addition, insertion orders
(whether or not they’re created automatically) can be prebilled from the
Purchase Orders window.

There are slight differences between insertion orders created from print
media plans vs. media estimates.  Since media estimates are completely
customizable, the insertion order’s column headings may vary from insertion
to insertion.  The column headings on insertion orders made from print
media plans will always be consistent.

To create an insertion from a print media plan

1  From the Media window click on the Print Plans button.

The Print Media Plans window opens, listing the last-added print media
plan.

2  Find the print plan you wish to use.

3  Click the Make Insertion button.

The Make Insertion Order window opens listing all the buys for this plan.

4  Mark the check box next to each buy you wish to include on the
insertion order.

Each space buy will be added as a line item on the insertion order.

■  To create separate insertion orders for each space buy, click the Separate
insertion order for each buy option.

5   Click OK.

After a few seconds, the insertion order is saved.  Once saved, it can be
printed from Purchase/Insertion Orders.

Making Insertion Orders from Media Plans
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Click the Make Insertion button to
automatically make insertion orders
from print media plans or media
estimates.

1  The media plan (or media estimate)
name/title appears here for easy
reference.

2  Mark the check box next to a space
buy to include it on this insertion
order.

3  This is the name of the currently
selected publication.

4  The space buy’s scheduled month
will be listed.  For daily or weekly
publications the day or week will be
listed instead.

5  The  ad’s space describes it’s
location within the publication.

6  The space buy’s gross cost.

7  To create separate insertion orders
for each of the media buy’s issues, use
the separate insertion orders for
each buy option.  This option creates
a separate insertion order for each
issue date.  For example, a full year’s
worth of ads for a yearly publication
will generate twelve separate insertion
orders.  They’ll have different issue
dates, but all will have the same order
date.

The Make Insertion Order window
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Insertion Orders

Any kind of ad space ordered on behalf of a client should be tracked with
insertion orders. They are essential for accurate job costing. They allow
media costs to be committed to a job before the publication’s invoice is
posted. You’ll know at any given time how much media space is ordered.

Insertion orders are designed primarily for print space buys, but are
completely customizable. The insertion order’s field labels can be easily
tailored for outdoor, internet,
and other types of media.
Insertion orders can be added
by users, or created
automatically from media
estimates. Once insertion
orders are saved, they can be
pre-billed immediately
(showing one insertion order
by client invoice) or billed in
batches on a media invoice.
For easy reconciliation, each
space buy is updated with
the A/R invoice number and
the billed amount once the
insertion order is invoiced.

When the ad eventually runs,
it will be invoiced by the
pub. As the pub’s invoice is
posted, the insertion order’s
balance decreases. The open
purchase/insertion order
report keeps a running
balance of open commitments, showing how much you’ve ordered that
hasn’t been invoiced by its pubs. Once the invoice is posted into A/P, an
insertion order can’t be changed.

Insertion orders have separate preferences from purchase orders. The agency
name, address, disclaimer, and logo can be different than purchase orders.
(This is especially useful for in-house agencies that need to maintain a
separate identity from the corporation in order to get agency discounts.)
Insertion orders are numbered separately from purchase orders, and have
a unique numbering sequence to keep them apart.

The vendor’s rep name, phone, and fax number are copied from the
Publication Table when an insertion order is added, but can be edited
directly on the insertion order through the Vendor Info window if needed.

Insertion orders can be cloned, like purchase orders. Cloning an existing
insertion order makes an exact duplicate that you can modify then print.
Changing the new insertion order doesn’t affect the original insertion order.

■  Anyone can add an insertion order if they have the access privileges to

Insertion Orders

purchase orders. Also, insertion orders can be added from any computer
running Clients & Profits. Many users can add IOs at the same time.

To add an insertion order

1  Choose Accounting > Purchase/Insertion Orders.

2  Choose Edit > Add >
Insertion Order.

The Add Insertion Order
window opens. The new
insertion may be
numbered automatically
(based on your prefer-
ences); if so, you’ll see
the next number. If not,
you can enter your own
insertion order number.

The insertion order
number can contain any
combination of letters,
numbers, and symbols. The
number is limited to
twelve characters.

3  Enter the new insertion
order’s vendor number.

Insertion orders are added for one vendor, so a vendor number is required.
One vendor can produce many publications so the specific publication name
is entered on the Publication field.

■  If you don’t know the vendor number, leave it blank then press Tab. The
vendor lookup list opens, displaying your vendors. Double-click on a vendor
to copy its number to your new insertion order.

4  Enter the insertion order’s job and task.

The insertion order must have a job and task for accurate cost tracking.
When the insertion order is saved, the media’s cost will update the job
task’s Net POs balance.

5  Enter the publication, issue date, ad/caption, and other details.

These fields appear in the body of the printed insertion order. The standard
settings are designed for typical print buys, but can be customized (without
affecting other insertion orders).
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The Add Insertion Order window

1 The order number identifies an
insertion order on windows, reports,
and forms.  IOs are numbered
automatically when added or when
saved, based on preferences, or
manually. Insertion orders have a
different numbering sequence than
purchase orders.

2  An IO has only one vendor. It is
usually the company that owns the
publication (or it might be the
publication itself).

3  The order date  is the date on
which the insertion order was added.
It appears on the printed insertion
order.

4  Every insertion order needs a job
and task for accurate cost accounting.
The insertion’s cost will update the job
task’s Net POs total.

5  Ordered by is the initials of the
person who added the insertion order.
Later, insertion orders can be printed
in batches by ordered by initials.

6  The publication name is copied
from the Publications table, which
links the pub’s ad sizes with inserton
orders.

7  The campaign code can be used to
categorize media expenses. The brand
name helps to identify the product line
being advertised. Both are optional.

8  The issue date shows the week,
month, or period of time each media
buy runs. The ad/caption describes
the specific advertisement that’s being
run for this space buy. The ad name/
size is a combination of the ad/
capation and ad size fields, but can be
changed. It appears on media billings.

10  Space close is the date on which
you must place this order with the
publication. Materials due is the date
on which the ad’s film, disk, or other
materials must reach the publication.

11  Position is a customizable text
field that can store notes or special
instructions that appear on the printed
insertion order.

12  Gross cost is the amount you’re
charging the client for this ad. The
commission is copied from the client,
and is used to calculate the ad’s net
cost. Net cost is the amount you’ll pay
the publication for the ad.

13  The bill net, not gross option lets
you pass the ad’s true cost along to
the client, without any agency
commission.

14  Added by shows who added the
insertion order.

q
w

e

r

t

y u

i

o
p

a

s

d

f



38 Insertion Orders

The ad#/caption field contains some kind of reference to help the client
and the publication track the ad. It can be the ad’s headline, tagline, or a
marketing code. It’s completely customizable and appears on the client’s
media invoice. The position field is a long block of text that can include
information, special instructions, or notes about the space order. This text
appears on the printed insertion order, so don’t enter anything confidential
or proprietary. The label named “position” can be customized.

6  Enter the ad’s gross cost,
commission, and net cost.

The ad’s gross cost is the amount
you will eventually charge the
client, including your agency
commission.  The media commis-
sion percentage is copied from the
vendor account. It can be
customized on an insertion order
without affecting other orders. The
commission is used to calculate the
ad’s net cost automatically. If the
ad has no commission, enter the
commission percentage as zero. The
ad’s net cost is the amount you’ll
pay the publication, less your
agency commission.  When the
publication invoices you for this
ad, the invoice amount should
match the insertion’s net cost—
if not, you’ll be either over or
under budget.

7  Click Save.

Once the new insertion order is saved,
it can be printed, revised, and reprinted
many times.

Pre-billing an insertion order

Insertion orders can be pre-billed directly from the Purchase/Insertion
Order window. The pre-bill invoice shows the insertion order’s publication,
issue date, gross cost, and other details. Many insertion orders can be billed
on the same invoice by adding a media billing in Accounts Receivable. The
media invoice shows each insertion order’s publication, issue date, ad/
caption, and other details. For more information, see page 4-17.

To edit an insertion order

Insertion Orders (con’t)

An insertion order can be edited and reprinted as many times as needed.
The Edit Insertion Order lets you change the vendor, order date, and other
details. If an insertion order has only one media buy (i.e., line item),
everything about the order, including amounts, can be edited. If the
insertion has multiple media buys, only the order date, status, and position
can be changed here.

1  From the PO/IO window click the
Description button.

2  Enter your changes, then click Save.

To add additional media buys to
an insertion order

An insertion order can contain dozens of
different media buys for one vendor. Each
media buy can specify a different ad to
run, a another set of run dates, or a special
space buy for a certain ad. Each media buy
will appear as a separate line on the
printed insertion order, as well as the
client’s A/R invoice. When the vendor’s
media invoice is eventually entered, you’ll
also reconcile A/P and insertion orders
line-by-line.

1  Click the  (i.e., Add Buys) button, or
choose Edit > Add Amounts.

2  Enter the new media buy’s details (especially its line number, which is
crucial for accurate A/P reconciliation) then click Save.

To edit a media buy on an insertion order

1  From the PO/IO window, double-click on a media buy.

2  Make your changes, then click Save.

■  For information on removing amounts from orders, making revisions, pre-
billing, and updating order status see the Editing Purchase Orders section
on page 3-14.

To print an insertion order

1  Choose File > Print Purchase Orders, or click the  (i.e., Print Form)
button.

Printing copies.  Since laser
printers can’t use multi-part forms,
Clients & Profits prints up to five
copies on an insertion order. A copy
will be printed on plain paper for
any distribution name entered into
the Options window.
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The Edit Buy window

1 The vendor name is the publisher.
Only one vendor can be added to each
insertion order.

2  The balance is the difference
between the line item’s net cost and
the actual cost from the order’s posted
A/P invoices.

3  The line number identifies
particular media buys on the IO.

4  Every media buy needs a job and
task for accurate cost accounting. The
insertion’s cost will update the job
task’s Net POs total.

5  The publication is copied from the
Publication table or entered manually.
To see the Publication lookup list,
leave the field empty then press Tab.

6  The issue date describes when the
ad will run. The ad#/caption is used
to identify the particular advertise-

ment that will run in the publication.
If the ad size field is empty, pressing
Tab will open the pop-up Ad Sizes
lookup list. This lookup list shows the
publication’s ad sizes and rates.
Double-clicking on an ad size copies
its information to the media buy. All of
these description fields are user-
defined and optional.

7  The bill net, not gross option lets
you pass the ad’s true cost along to
the client, without any agency
commission.  This option applies only
to clients that pay a retainer to you
for media planning, they pay only the
ad’s net cost.

8  The ad/size is entered as the
combination of the media buy’s ad
number/caption and the ad’s size, but
is customizable. Anything that
effectively describes the media buy
can be entered here. It appears on the
printed insertion order and the A/R
invoice.

9  Space close is the date on which
you must place this order with the
publication. Materials due is the date
on which the ad’s film, disk, or other
materials must reach the publication.

10  The media buy’s notes are
optional. They can be used for
instructions specific to certain line
items on the insertion order. They
appear on the printed insertion order.

11  Gross cost is the amount you’re
charging the client for this ad. The
commission is copied from the client,
and is used to calculate the ad’s net
cost. Net cost is the amount you’ll pay
the publication for the ad.

12  When an insertion order is billed
in A/R, the media buy’s billed on
A/R# details are updated. The media
billings’s invoice number and billing
amount appear here with the invoice is
posted.
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Broadcast Media Plans

Broadcast media plans can be created for many kinds of radio, television,
cable, or even Internet-based media buys.  Like a print plan, a broadcast
media plan is similar to a job ticket:  it is opened for one client, has a
number to track it, can be changed many times as needed, and printed for a
client’s approval.

A broadcast media plan is made up of one or more media buys.  A broadcast
spot buy (usually a specific
time or program) is made for
each station that is part of the
media plan.  A broadcast media
plan can contain dozens of
time/program spot buys.  You’ll
enter the flight’s beginning
and ending dates on the
broadcast plan.  Each spot can
be run any number of times
during the two-week flight.

The broadcast media plan
window shows the plan’s
number, client, title, budget,
and media buys.  For each spot
buy you’ll see its station,
time/program code (or name),
total spots, total rating points
ordered, gross cost, and
number of times per day that
the spots will run.

To find a broadcast media plan

1  From the Media window click on the
Broadcast Plans button.

The Broadcast Media Plans window
opens, listing the last-added broadcast media plan.

2  Click the  (i.e., Find) button.

3  Enter the broadcast plan number, or choose a different find option from
the Find By pop-up menu.

You can find broadcast media plans by number, client, title, campaign, start
date, or sequence (i.e., the order in which they were added).  To find a
broadcast plan for a selected client:  Click the Find button, then choose
Client from the pop-up menu.  Enter the client number, then click Find.  The
first broadcast plan for the chosen client appears.

4  Click Find.

Broadcast Media Plans

■  Click the Next or Previous button to browse through other broadcast
media plans.

To work with a broadcast media plan

1  From the Media window
click on the Broadcast Plans
button.

The Broadcast Media Plans
window opens, listing the
last-added broadcast media
plan.

2  Find the broadcast media
plan you wish to use.

The Broadcast Media Plan
window opens, showing the
plan’s space buys.  From
this window use the toolbar
buttons to edit, delete, and
print this broadcast plan.

Finding media plans.  Broadcast
and print media plans can be easily
found by plan order, client number,
name/title, start date, or campaign.
Double-clicking on a media plan in
the Find list displays its full details,
including its buys.
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The Broadcast Media Plan window

1  Use the window’s find, next, and
previous buttons to locate or browse
through media plans.

2  The window’s toolbar buttons let
you add, edit, delete, and print a
broadcast media plan.

3  Use these buttons to add and
remove space buys to this broadcast
media plan.To edit a space buy,
double-click on the station in the list.

4  Click the broadcast worksheet
button to print the Broadcast Work-
sheet which shows the plan’s buys in
detail by station and the total number
of spots, cost, and rating for each
station and for the entire plan.

5  The make insertion button creates
insertion orders automatically from a
selected space buy.

6  Each print media plan is tracked by
a media plan number. Media plans are
numbered automatically by client.
Each client has its own numbering
sequence for easy tracking. A media
plan’s number can’t be changed. Print
media plans are opened for a single
client, just like a job ticket.  The client
number will be copied from the media
plan to insertion orders and, even-
tually, to media invoices. The media
plan’s name/title appears here for
reference.

7   The campaign code is displayed
here for easy reference. The media
plan’s optional budget, if entered,
appears here.  The buyer initials are
copied as the person adding the media
plan, but can be changed.

8  The broadcast media plan’s spot
buys are listed by station. Each spot
buy contains a station name, the time/

Broadcast Media Plans

program name during which the spots
will be running, the length of each
spot, the number of spots, total rating
points, and the spot buy’s total gross
cost. Double-clicking on a spot buy
displays its complete details.

9  The broadcast media plan’s total
spots, rating, cost, and other
summary totals appear here for easy
reference. The CPP is the cost per
rating point and the CPS is the cost
per spot.
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Adding a Broadcast Media Plan

Broadcast media plans are added like job tickets:  first you’ll enter the new
plan’s client, number, name/title, and description, then add the plan’s spot
buys.

Each broadcast media plan is identified with a plan number.  New broadcast
plans are numbered automatically by client, but can be changed.  You can
enter a name/title for the broadcast media plan, as well as a long
description.  Both fields appear on broadcast media plans (so clients see
this information).  The broadcast media plan contains date fields (for date
started and date ended), an optional campaign code, and a budget amount.
The budget amount is for reference only, and can be ignored; it has no
affect on job costing.  A broadcast media plan contains one job and task.
They are copied automatically to the plan’s insertion orders, and can be
changed.

The broadcast media plan contains spots planned to run over a two-week
period, called a flight.  The flight schedule specifies the time frame over
which the spots will be shown.  Flight dates are customizable, and appear
as column headings for the spot buys.  When you enter in the first day of
the flight, the following fourteen days are entered automatically.

A broadcast media plan has six optional user-defined fields.  These fields
are customizable, so can contain any kind of information that isn’t already
in the plan’s description.  You can show these fields on custom reports for
better media tracking.

Most of the information entered on a broadcast media plan is included on
the printed broadcast plan that the client will approve.  A broadcast media
plan can be revised then reprinted any number of times.

1  From the Media window click on the Broadcast Plans button.

                      

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Click the  (i.e., Add New Media Plan) button, or choose Add New
Broadcast Plan from the Edit menu.

The Add Broadcast Media Plan window opens, prompting you to enter the
new plan’s client.

3  Enter a client number, or press Tab to open the Clients lookup list.

4  Enter the broadcast media plan’s number, or press Tab to keep the
automatically-created number.

Adding a Broadcast Media Plan

New broadcast media plans are automatically numbered by client. The
automatic number includes the client number, the next plan number, and a
code indicating the plan’s kind (i.e., “B” for broadcast and “P” for print).
The client’s media plan number will be incremented when the plan is saved.

6  Enter the broadcast media plan’s name/title, start date, end date, budget
amount, campaign, and AE/team.

The name/title should briefly describe the plan’s objective. It appears on
the printed media plan, so the client will see it. The start and due dates are
used by media reports. The plan’s budget amount, campaign, and AE/team
appear on the printed media plan for reference, but are optional.

7  Enter a job number and task for this broadcast media plan.

A broadcast media plan is opened for one job and task. The media plans
themselves don’t affect job tickets; instead, only the broadcast orders
generated from the media plans update a job and task. All broadcast orders
created from a plan get the same job number and task. If a default media
job and task is entered in the client window, it is copied here.

8  Enter the broadcast media plan’s description.

This description can explain in detail the media plan’s target market,
demographic, scope, or any other kind of information you’d want the client
to see on the printed media plan. It does not appear on the plan’s
broadcast orders.

9  Enter the days of the plan’s flight (i.e., the days during which the spots
will run).

10  Enter the plan’s user-defined fields.

The six user-defined fields can be used to store specialized information
about a broadcast media plan that otherwise has no place. These fields
don’t affect job tickets or even the plan’s broadcast orders. Instead, they
only appear on the printed media plan and on custom reports you create
with them.

11 Click Save.
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The Add Broadcast Media Plan window

1  Every media plan is opened for one
client.

2  Media plans are numbered auto-
matically. Media plans are numbered
separately by client. Each client has a
special media plan number. The
media plan number is a combination
of the client account number and its
special media plan number. The client’s
media plan number increments auto-
matically as each new plan is saved.
The media plan number is customiz-
able.

3  The name/title appears on the
printed media plan. It should be a
brief description of the plan’s
objective.

4  Each time the broadcast plan is
changed the revision number can be

manually incremented to show the
number of revisions made. The
previous revisions are not retained.
Revision zero appears as Original on
the printed Broadcast Worksheet and
the printed Broadcast Media Plan.

5  Date started and date ended track
when the plan was opened and closed.
An optional campaign code can be
used by custom reports to analyze
media buys by client.  Broadcast media
plans can be given an optional AE/
Team name. Media plans can be
analyzed on custom reports by AE/
team.

6  Enter the optional budget amount
as the expected total of the media
plan’s spot buys.

7  Broadcast media plans don’t directly
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Adding a Broadcast Media Plan

affect job tickets until broadcast
orders are created. A media plan’s
broadcast orders gets their job
number and task from these fields.
All orders created from this broadcast
media plan use the same job and task.

8  This long description explains the
plan’s objectives, specifications, or
other important information. This
description appears on the printed
media plan, but not on broadcast
orders.

9  The broadcast plan’s two-week
flight schedule is customizable.
These are the days on which the spots
will run.

10  Each broadcast media plan con-
tains six user-defined fields. Use
these fields to capture key details

about the media plan that isn’t
included in the description. These
optional fields appear on the Broad-
cast Worksheet and can be printed on
custom reports.

11  The buyer’s initials are copied as
the person adding the media plan, but
can be changed.

12  The commission percentage is
copied from the client file, but can be
changed here.
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Adding Buys to a Broadcast
Media Plan

The broadcast media plan is incomplete without spot buys for times and
programs.  A separate spot buy is added for each time or program during
which the ad will run.  So a broadcast plan could have dozens of buys for
different stations and programs.  There’s no limit to the number of stations
and programs that can be ordered for the plan’s two-week flight.

Spot buys on broadcast media plans use information from the Stations
table, so you don’t need to reenter the station name and address.  (If you
don’t know the name of the station, the lookup list opens automatically.)
Time, program, rating, and cost information is copied from the Times/
Programs table, and can be customized on any spot buy.  The time/program
name is important.  If the time/program name is found in the Times/
Programs table, its rating cost is copied to the space buy.  If the name
doesn’t match, you’ll need to enter the program’s rating and per-spot cost
manually.  To see a list of the station’s times and programs, click the
Lookup Times/Programs button to open the lookup list; double-clicking on
a time/program copies it to the spot buy.

You’ll enter the number of times a spot will run during each day of the
flight.  Clients & Profits Pro calculates the buy’s total cost, rating, number
of spots automatically.  This information appears on the printed broadcast
plan and media worksheet.

You can add, change, and remove spot buys from a broadcast media plan
any time—just like tasks can be added, edited, and removed from jobs.
Once you’ve added all of the media plan’s spot buys, it can be printed for
the client’s approval.

To add a broadcast spot buy

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to use.

3  Click the Add Spot Buy button.

4  Enter the spot buy’s station code, then press Tab.

If you don’t know the station code, leave it blank then press Tab to open
the lookup list.  Double-click on a station to copy it to this spot buy.  You
can also add a new station from the Lookup window by clicking the Add
button.

5  Enter the dates, days, and times these spots will run.

6  Enter the time or program.

To see a list of the station’s times and programs, click on the Lookup

Times/Programs button.  Double-clicking on a time/program copies it to the
spot buy.  If the time/program has been already set up, its rating and cost
will appear automatically.

7  Enter the name/title for the spot that will run on this station.

8  Enter the total number of times the spot will run during the flight.

9  Enter the length of each spot (e.g., :30 for 30 seconds).

10  Enter the optional buy notes, then click Save.
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The Add Broadcast Buy window

1  The client and broadcast plan title
appear here for reference.

2  The flight dates are copied from
the broadcast plan.

3  A separate spot buy is added for
each time or program during which the
spot will run. If you don’t know the
station code, leave the field blank
then press Tab. The stations Lookup
window opens. Double-click on a
station to copy it to the spot buy.
The address button lets you change
the station’s address for this spot buy
only (the station’s regular address is
unaffected).

4  The dates, days of the week, and
times this spot will run are entered
here.

5  The space close and materials due
dates listed here will appear in the
Media window to remind you of the
upcoming space and traffic deadlines.

6  The spot runs during a specific
program or, if the program isn’t
important, a time of day. The time/
program field contains the name of
the time or program for the station.  It
uses the Time/Program/Contract Rates
table to save time, but you can enter
your own times/programs directly if
needed. If the time/program has been
set up in the Time/Program table, its
rating and cost will be copied to the
spot buy; otherwise, you’ll need to
enter the rating and cost manually.
Click on the Lookup Times/Programs
button to see the station’s time and
programs.  This lookup window opens
only if you’ve selected the first line for
each month.

7  The spot name identifies the ad on
the printed broadcast media plan. Any
kind of description text or  code can
be used.  (It is similar to the ad#/
caption in print media plans.)

8  Enter the number of times the spot
will run here.

9  Use the buy notes to describe the
spot buy’s specifications, objectives, or
special instructions.

10  The program’s rating and cost are
copied from the Times/Programs table,
if available. The rating and cost for
each program can customized without
affecting the Times/Programs table.

11  The total number of spots, total
rating, and gross cost are calculated
automatically based on the flight and
the show’s rating information.

12  Once a broadcast order is
generated for this buy, the order
number will be referenced here.

Adding Buys to a Broadcast Media Plan
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To edit a broadcast media plan

Everything about a broadcast media plan can be edited, except for the
client number and the media plan number.

1  From the Media window click on the Broadcast Plans button.

                   

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to change.

3  Click the  (i.e., Edit) button.

The Edit Broadcast Media Plan window opens, displaying the plan’s number,
name, description, flight dates, and other details.

4  Make your changes.

5  Click Save.

To delete a broadcast media plan

A broadcast media plan can be deleted anytime before broadcast orders are
created.  Once you’ve ordered spots for the media plan, it can’t be deleted
(unless you delete the broadcast order first).

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to delete.

3  Click the  (i.e., Delete) button.

To print a broadcast media plan

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to print.

3   Click the  (i.e., Print) button.

To print a broadcast media worksheet

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to print.

3   Click the  (i.e., Print Broadcast Media Worksheet) button.

The Broadcast Media Worksheet shows more detail than the Broadcast Media
Plan.

To change a buy on a broadcast media plan

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to change.

3  Double-click once on a broadcast buy.  Or, click once on a buy to select
it then click the Edit Buy button.

4  Make your changes, then click Save.

Buys on a broadcast media plan can be deleted anytime before broadcast
orders are added.  Once you’ve ordered space for the media buy, it can’t be
deleted (unless you delete the broadcast order first).

To delete a buy from a broadcast media plan

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to change.

3  Click once on a broadcast buy to select it.

4  Click the  (i.e., Remove) button.

Working With Broadcast Plans
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Making Broadcast Orders from
Broadcast Media Plans

Broadcast orders can be created automatically from broadcast media plans.
This option can save hours of data-entry time, since there’s nothing to
reenter.  Instead, the information from the media plan—the station, flight
dates, program, rating, and costs—are copied directly to the new broadcast
orders.

Creating automatic broadcast orders is easy:  find the media plan, select the
space buy, then click the Make
Broadcast Orders button.  A list of
the broadcast media plan’s buys
will be listed.  Marking the check
box next to a buy will include it
on the broadcast order.  A
separate broadcast order will be
created for each station.  Each
buy for a station will appear as a
line item on the broadcast order.

Automatic broadcast orders use
the same media preferences as
manually added insertion/
broadcast orders.  That is, they’re
numbered in the same order and
have the same settings (such as
the disclaimer).

Once the new broadcast order is
saved, it can be reviewed, edited,
and printed from Purchase/
Insertion Orders.  In addition, broadcast
orders (whether or not they’re created
automatically) can be prebilled from the
Purchase Orders window.

To create a broadcast order
from a broadcast media plan

1  From the Media window click on the Broadcast Plans button.

The Broadcast Media Plans window opens, listing the last-added broadcast
media plan.

2  Find the broadcast plan you wish to use.

3  Click the Make Broadcast Orders button.

The Make Broadcast Order window opens listing all the buys for this plan.

4  Mark the check box next to each buy you wish to include on the
broadcast order.

Making Broadcast Orders from Media Plans

Each space buy will be added as a line item on the broadcast order.

5   Click OK.

After a few seconds, the broadcast order is saved.  Once saved, it can be
printed from Purchase/Insertion Orders.

Printing copies.  Since laser
printers can’t use multi-part forms,
Clients & Profits prints up to five
copies on an insertion order. A copy
will be printed on plain paper for
any distribution name entered into
the Options window.
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Radio, cable, and broadcast television spots ordered on behalf of a client
should be tracked with broadcast orders. Like purchase and insertion orders,
they are essential for accurate job costing. They allow media costs to be
committed to a job ticket before the station’s invoice is posted. This way
you’ll know at any given time how many media spots have been ordered.

Broadcast orders can be added one-by-one by media buyers, created
automatically from media estimates, or imported from media buying
systems like TAPSCAN,
SmartPlus, or Strata using the
optional C&P Media Link. Once
broadcast orders are saved,
they can be pre-billed
immediately or billed on a
media invoice. For easy
reconciliation, each buy on the
broadcast order is updated with
the A/R invoice number and
the billed amount once the
broadcast order is invoiced.
When the media buys
eventually run, they will be
invoiced by the station. The
station’s invoices are entered
into Accounts Payable,
referencing their broadcast
orders. As the media A/P
invoice is posted, the broadcast
order’s balance decreases.

■ Anyone can add a broadcast order if
they have the access privileges to pur-
chase orders. Also, broadcast orders can
be added from any computer running
Clients & Profits. Many media buyers can
add orders at the same time.

The same general rules for adding,
editing, and printing purchase orders apply to insertion orders and
broadcast orders.

To add a broadcast order

Like insertion orders, broadcast orders are added in two steps: first the
header then the media buys. The order’s header contains the vendor, date,
ad name, flight dates, and description.

1  From the Purchase/Insertion Orders choose Edit > Add Broadcast Order.

The Add New Broadcast Order window opens, prompting you to enter the
new order’s header information.

Broadcast Orders

2  Press Tab to keep the broadcast order’s order number.
New broadcast orders are numbered automatically based on your prefer-
ences, but the number can also be entered manually. The broadcast order
number is limited to twelve characters.

3  Enter the broadcast order’s station (i.e., vendor).

The same vendor list is used for purchase, insertion, and broadcast orders.
If you don’t know the vendor
number, leave it blank then press
Tab open the vendor lookup list.
Double-click on a vendor to copy its
number to your new broadcast order.

4  Enter the order date,  commis-
sion, flight dates, ad name, and
other details about this order.

The commission percentage is
copied from the vendor account, but
can be changed on a broadcast order
without affecting other orders.
These fields appear in the heading
of the broadcast order.  The
standard field headings are designed
for typical spot buys, but can be
customized.

5  Enter the additional instructions and the traffic instructions.

These fields provide space for a long block of text.  This text appears in the
printed broadcast order.

6  Enter the broadcast order’s job and task.

The broadcast order must have a job and task for accurate cost tracking.
When the order’s buys are saved, the job task’s Net PO balance is updated.

7  Enter the media buyer and media rep approval lines.

The approval lines print on the broadcast order with instructions for the
media rep.

8  Click Save.

To add media buys to a broadcast order

Media buys contain the specific details about each spot that will run on the
broadcast order. A separate media buy should be added for each combina-
tion of run dates, times, and programs. Each media buy includes informa

Broadcast Orders

Broadcast orders.  Broadcast orders
are added, edited, revised, printed,
and billed like purchase orders and
insertion orders. Dozens of separate
media buys can be added for the
same station on a broadcast order.
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The Add New Broadcast Order window

1 The number identifies a broadcast
order on windows, reports, and forms.
Broadcast orders are numbered
automatically when added or when
saved, based on your preferences.  Or,
you can number your orders manually.
Broadcast orders have the same
numbering sequence as insertion
orders.

2  An order has only one vendor which
is usually the company that owns the
station (or it might be the station
itself).  The vendor’s name and address
appear on the printed broadcast order,
but can be customized on each order.

3  Ordered by is the initials of the
person who added the insertion order.
Later, broadcast orders can be printed
in batches by these ordered by initials.

4  The order date is the date on which
the order was added. It appears on the

printed broadcast order. The commis-
sion is copied from the vendor, and is
used to calculate the buy’s net cost.

5  The body of the broadcast order is
completely customizable. The standard
field labels are designed for broadcast
orders, but they can be easily changed.
This information appears on the
printed broadcast order. Campaign and
brand are optional fields that are used
by media analysis reports.

6  Campaign and brand are optional
fields that are used by media analysis
reports.

6  Market and product are optional
fields that appear on the printed order.
The materials due date is used by
traffic reports and applies to first spot
on the broadcast order. It can be
customized for each media buy. An
extra user-defined field, labelled here

as contract number is optional and is
blank by default. Any name can be
entered here.

8  The description field is a long text
block. The label itself is customizable
for flexibility. Any kind of notes or
details can be entered here. This text
appears in the heading of the printed
broadcast order.

9  The add’l instuctions and traffic
instructions provide a space for
details. Both fields print on the
broadcast order below the line items.

10  Every insertion order needs a job
and task for accurate cost accounting.
The broadcast order’s cost will update
the job task’s Net POs total.

11  The Media Buyer and Media Rep
OK fields create approval lines on the
printed broadcast order along with the
rep instructions.
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Broadcast Orders (con’t)

Broadcast Orders

tion needed by the station to run the spots, include dates and times a
certain ad should run, as well as the program in which the spot appears. In
addition, the spot’s length, rate, rating points, and the number of times it
will run are included. Each broadcast order can contain dozens of different
media buys.

1  Click the   (i.e., Add Buys) button or choose Edit > Add Amount/
Media Buy.

The Add Broadcast Media Buys
window opens, prompting you to
enter the media buy’s details. Many
different media buys can be entered
at once. Tabbing past the total/week
field adds the media buy to the order
then copies it to the next new media
buy. This makes it easy to repeat the
same buy several times.

2  Enter the media buy’s details,
pressing Tab to move between fields.

3  Click Save to add these buys to
the broadcast order.

Once saved, each buy will appear as
a line item on the broadcast order.
Broadcast orders can be pre-billed
directly from the Purchase/Insertion
Order window or billed using a media
billing in Accounts Receivable. You have
the option to show each buy’s program,
date, and time details on the printed
media invoice.

To edit a broadcast order

1  Click the  (i.e., Edit) button or choose Edit > Edit Description.

2  Make any changes, then click Save.

Whenever a broadcast order is changed, you’ll be prompted to save it as a
revision. Each change you make can increment the revision counter to show
how many times an order has been revised. It’s optional, but appears on the
printed broadcast order for easy tracking. Prior revisions aren’t saved. The
revision number on an order can also be incremented manually.

To edit a media buy

Media buys on a broadcast order can be edited any time prior to billing.
Everything about an order’s buys can be changed except for the job number
and job task. Changing a buy’s amounts will update the PO totals on the job
ticket.
1  From the Broadcast Order window, double-click on a media buy.

2  Enter the media buy’s changes, then click Save.

Each buy will appear as a line item
on the broadcast order.

Broadcast orders can be pre-billed
directly from the Purchase/Insertion
Order window or billed using a
media billing in Accounts
Receivable.  You have the option to
show each buy’s program, date, and
time details on the printed media
invoice.

To print a broadcast order

1  Click the  (i.e., Print Form)
button or choose File > Print
Purchase Orders then follow the
prompts.

To clone a broadcast order

Like purchase orders, broadcast orders can be cloned. Cloning creates an
exact line-for-line duplicate on an existing order, which can then be
modified and printed. Changing the new broadcast order doesn’t affect its
original order. To clone a broadcast order, choose Edit > Clone.

To edit a broadcast order’s disclaimer

Insertion orders can be pre-billed directly from the Purchase/Insertion
Order window. The pre-bill invoice shows the insertion order’s publication,
issue date, gross cost, and other details. Many insertion orders can be billed
on the same invoice by adding a media billing in Accounts Receivable. The
media invoice shows each insertion order’s publication, issue date, ad/
caption, and other details. For more information, see page 4-17.

Editing a broadcast media buy.
Broadcast orders are added, edited,
revised, printed, and billed like
purchase orders and insertion
orders. Dozens of separate media
buys can be added for the same
station on a broadcast order.
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The Add Broadcast Media Buys window

1 The order number, description, and
vendor appear for reference when
adding media buys to a broadcast
order.

2  The ad’s run dates indicate the
specific date (or range of dates) during
which this buy’s spots will be
broadcast. It is not formatted for
dates, so any combination of letters or
numbers can be entered.

3  Days indicates the specific days of
the week during which the spots will
run.

4  Time shows the specific time (or
daypart) during which the spots will be
shown.

5  The program field describes the
specific TV or radio program where the
spots are being run.

6  The length field indicates the type
of spot being ordered (e.g., :15, :30,
:60, etc.).

7  The rate field is the gross cost per
spot, which is used to calculate the
media buy’s total gross.

8  Spots is the quantity of ads that
are being ordered for this media buy.

9  Each media buy’s total gross cost is
based on the number of spots x its
rate. The buy’s total net cost is
calculated as the gross x the order’s
commission, which was entered in the
broadcast order was first added.
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Make Goods

Make goods are compensation for ads that either never ran or ran
incorrectly. There are many different ways an print ad or radio/tv spot can
be compromised, providing less value for your client. For example, you
ordered for a guaranteed position in a magazine, but the ad actually ran
different, less desirable place.  Or, you placed a radio spot to air during a
certain show, but the ad ran during a different program. In these situations,
the publication or station will either offer to run the ad or spot again,
credit the entire amount of the
ad’s cost, or issue a partial
credit.

■  Make goods are not
available in Clients & Profits
Classic.

Make goods need to be added
to the original insertion order
or broadcast order so that the
shop’s job costing is accurate.
If make goods aren’t entered
as they happen, your job costs
won’t match up with your
commitments.

It’s the media buyer’s
responsibility to match the
station’s affidavits or the
publication’s tear sheets to
verify that the ads or spots
that actually ran match what the shop
ordered. Any descrepancies needs to be
noted on the client’s broadcast or insertion
orders by adding make goods.

Make goods are simply additional media
buys appended to an insertion order or
broadcast order after the ads or spots
have been run. They’re functionally no
different from an order’s regular media buys—each make good line item
includes details about the dates, times, programs, etc. of the affected print
ad or radio/tv spot. Make goods will have a negative cost amount if the
station/publication is offering a credit; otherwise, free make good ads will
have a no cost at all.

When make goods are added, they update the job’s commitment totals just
like the original order. They appear on media reports just like other media
buys. When the station or publication media invoice is added into Accounts
Payable, they are reconciled along with the order’s original media buys.

To add a make good for a broadcast order

Editing a broadcast media buy.
Broadcast orders are added,
edited, revised, printed, and
billed like purchase orders and
insertion orders. Dozens of
separate media buys can be
added for the same station on a
broadcast order.

1  From the Purchase/Insertion/Broadcast Order window, find the broadcast
order that needs the make good.

2  Click once to highlight the media buy wasn’t run or run incorrectly.

3  Click the  (i.e., Add Make Good) or choose Edit > Add Make Good.

The Add Broadcast Make Good
window opens, prompting you to
enter the make good’s details.
The media buy’s details are
copied to the make good line
item except for the date, time,
and program.

4  Enter the dates, days, time,
and program for which this make
good spot will run.

The dates, days, etc. is based
the compensation negotiated
with the station.

5  Enter the rate, spots,
amounts, and other details for
this make good, then click Save.

To add a make good for
an insertion order

1  Find the insertion order that needs the make good.

2  Click once to highlight the media buy wasn’t run or run incorrectly, then
click the  (i.e., Add Make Good) or choose Edit > Add Make Good.

3  Enter the issue date, ad caption, and ad size for which this make good
ad will run, based the compensation negotiated with the publication.

4  Enter the rate, spots, amounts, and other details for this make good,
then click Save.

Reprinting the revised broadcast or insertion order

Once the make good is saved, the broadcast or insertion order can be
reprinted and faxed to the station, if necessary. For clarity, the reprinted
order will show the original media buys plus the make goods.

1  Choose File > Print Purchase Orders then follow the prompts.
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Media Goals

The Media Group Performance - Trend Analysis report compares actual media
spending for each kind of media (e.g., broadcast TV, radio, etc.) with the
media department’s billing goals. For these reports to work properly, the
shop’s billing goals for each media kind must be entered in the Media Goals
window. Media billing
goals, which are
based on gross
amounts on broadcast
and print insertion
orders, can be
entered for each
quarter of the
calendar year. For
more information
about media
spending reports, see
page 62.

■  Media goals are
not available in
Clients & Profits
Classic.

To enter the
shop’s media
billing goals

1  Choose View > Media Plans (Media
Estimates).

2  Click the  (i.e., Media Goals)

button, or choose Edit > Media Billings
Goals.

The Media Goals window opens,
displaying a worksheet with the quarterly billing goals for the eight
different kinds of media.

2  Enter the quarterly billing goals for each of the media kinds.

3  Click Save.

These media billing goals can be edited any time. They are used only for
media reports, and do not affect job tickets, media plans or estimates, job
costing, or the General Ledger.

Use the media billing goals as a
planning tool.  Broadcast orders are
added, edited, revised, printed, and
billed like purchase orders and
insertion orders. Dozens of separate
media buys can be added for the
same station on a broadcast order.
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Importing Orders with the Clients
& Profits Media Link

Key features How the Media Link works

The Clients & Profits Media Link is a stand-alone application that imports
broadcast orders, print insertion orders, and vendor invoices from popular
media buying systems into your C&P database. It imports media orders and
invoices from SmartPlus, Strata, Tapscan, and other media buying systems
that support the Standard Media Interface.

There are two versions of the Media Link. Both are exactly alike, except for
the version of Clients & Profits with which each works. The C&P Media Link
3.0 works with Clients & Profits Classic 3.x, Clients & Profits Pro 3.x, and
Job Tracker 3.x. The C&P Media Link 4.0 works with the newest versions of
Clients & Profits Classic 4.x, Clients & Profits Pro 4.x, and Job Tracker 4.x.
The Media Link version you use depends on which version of Clients &
Profits you’re using.

■  The “standard media interface” is a technical specification that defines
the interface between media buying systems and accounting systems like
Clients & Profits. It is a generic interface designed especially for ad
agencies to simplify tranferring data between media buying systems and
accounting programs. The SMI specification is used by developers to
program export files from media to accounting. You don’t need to know
anything about the SMI in order to use the C&P Media Link. For more
information on the SMI, see www.clientsandprofits.com/media/
SMI_specs.html.

Media buying systems that support SMI, such as SmartPlus, export station
and publication orders from media plans into specially-formatted text files.
A separate text file is created for each broadcast order, insertion order, or
vendor invoice. Each text file includes the details of the order (e.g., station
ID, run dates, number of spots, rating, cost, etc.) or invoice needed by
Clients & Profits for job costing, billing, and media accounting.

Here’s how it works:  A media buyer enters broadcast orders, insertion
orders, and vendor media invoices are entered into SmartPlus, Tapscan, or
Strata. The media buying system then saves a copy of the order as a text
file on your file server. The C&P Media Link looks for these export files
(either one at a time or automatically at different intervals), bringing the
data into your Clients & Profits database as broadcast orders. The station
orders appear in the Purchase/Insertion Orders window as broadcast
orders—just as if you’d typed them in yourself. Once imported, these orders
can be billed to clients just like any other broadcast order.

The C&P Media Link application lets you import media buys as they happen,
one at a time. Or, automatic importing can be scheduled at various intervals
(e.g., every hour, every day, etc.). This option lets you run the C&P Media
Link unattended on a spare computer somewhere in the office, importing
new buys automatically throughout the day.

The C&P Media Link really pays off when you’re buying large amounts of
broadcast or print media. Rekeying dozens of buys each week into Clients &
Profits would be tedious and probably error-prone. Since the Media Link
imports the actual media buy, there’s no double-entry and no missing data.

■  TV and radio media orders are
imported directly into your Clients
& Profits database as broadcast
orders.

■  Print media orders are imported
into C&P as insertion orders.

■  Vendor media invoices are
imported into C&P as unposted
A/P invoices.

■  Media buys can be manually
imported, one-by-one, or
automatically imported at selected
intervals (e.g., every 15 minutes).

■  The Media Link is designed to
handle high-volume media
departments. It can effectively
import hundreds of media buys
each day.

■  It can be run on either a
Macintosh or Windows-based
computer.

■  The Media Link validates each
media buy for a valid client and
vendor. A user-defined option lets
the Media Link add a new client or
vendor automatically, or not
import the media buy.

■  Imported media buys can be
billed, or even pre-billed, just like
other media orders you’ve entered
manually.

■  A detailed log keeps track of
every imported media order,
indicating which ones had errors.

■  Imported media buys appear on
PO reports, job reports, and WIP
reports—anywhere media orders
are normally found.

■  An e-mail notification can be
automatically sent each time a
new media order is imported.

The media department starts the
process by adding media plans into
their media buying system (e.g.,
Tapscan, SmartPlus, Strata, etc.).
When the buyer finalizes the plan
and places the order, the media
buying system exports the order
and its buys into a specially-
formatted text file—one for each
order. This file is saved into a
special folder  (named “media_
buys”) on the file server.

The export file contains the details
of the media order, including
station/publication, run/issue
dates, number of spots, cost, and
more (they’re slightly different for
broadcast and print orders). These
files are held in the media_buys
folder on the file server until they
are imported by the Media Link.

The C&P Media Link opens these
text files, determines whether the
file contains a broadcast order,
print insertion order, or vendor
invoice then saves the data into
the Clients & Profits—just as if it
were entered personally. The
export file is then moved
automatically to the imported_buys
folder for storage just in case it
there’s an error and it needs to be
imported again.

To use the Media Link, you’ll first
need to configure the media
buying system to save its export
files into the C&P folder on your
file server (you’ll probably need
help from the media system’s
helpdesk with this.) There’s
nothing on the server to configure;
since both Macs and Windows-
based PCs can usually access the
same file server, any kind of
computer can be used for the
Media Link.

Importing orders with the C&P Media Link

You’ll also find more information about the C&P Media Link and the Standard
Media Interface here:  www.clientsandprofits.com/media/media_link.html
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Media Buyer

Accounting Department

File Server

The media buying system saves SMI-based export
files to the “drop” folder called media_buys

The C&P Media Link looks for new broadcast order, insertion order,
or vendor invoice export files in the “drop” folder, imports them,

then stores them into the import_buys folder

The file server doesn’t do anything except store the newly-created
media export files and the imported export files.

The “drop” folder, called media_buys, is created automatically
the first time the C&P Media Link is opened. It is added the

same folder/directory that keeps the C&P database.

The media buying system needs to be
configured to save new media export

files into this drop folder.

Broadcast order export files end
with .TBY (or .BUY). Insertion

order export files end with .PBY.
Vendor invoices end with .VAP

Media export files are named with the
broadcast/insertion order’s number, so
each text file will have a unique name.
Orders than span several months are
exported as separate text files, one for

each month; in these cases the month is
added to the order number.
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1.  Click the Import
button, then find and
open the “media_buys”
folder

Media orders and invoices can be imported individually or imported
automatically at user-defined intervals (e.g., once a day, every hour, every
five minutes, etc.). If the media buyers place fewer than 10 orders a day,
they can be easily imported one-by-one. If your agency is heavily involved
in media buying and places many orders each day, the automatic importing
is much more practical. In this case, a spare Mac or PC needs to be set up
on the network just for the Media Link. When enabled, the C&P Media Link
will automatically look for any new (or revised) media buys then import
them into Clients & Profits.

It’s important to verify that imported media buys were imported accurately.
A routine needs to be established between the media and accounting
departments to double-check the day’s media orders. When a station order
is made by a media buyer, they should print a duplicate copy for the
accounting department. When the media order is imported by the C&P
Media Link, the accounting department should compare the printed media
order to the imported order in Purchase/Insertion Orders. If the order
number, number of media buy lines, total rating, total spots, and net and
gross amounts match then the order was imported correctly.

■  Importing media orders and invoices is a one-way process. Since the
media buying system takes priority over Clients & Profits for media
ordering, all changes and revisions to a media order must be made in the
media buying system. Changing an imported media buy in Purchase Orders
will not update the media buying system—and will cause billing and cost
accounting problems.

■  The order number is assigned by the media buying system, not the C&P
Media Link. It has to be unique, or else the order will be handled as a
revision. When a revised media order is imported, it completely replaces the
original broadcast or insertion order. The same media can be revised and
reimported any number of times.

Importing Media Buys

Importing Media Buys

How the C&P Media Link
handles vendor invoices

If you use your media buying
system to reconcile media orders
with vendor invoices, those
invoices can be automatically
imported into your C&P database
using the Media Link.

The Media Links imports vendor
media invoices into the Accounts
Payable data file, where they
appear as unposted invoices.
Imported invoices contain the
media order number and other
details necessary for reconcilia-
tion, so there’s nothing more to
enter. Vendor invoices are
imported as job costs (or as media
accruals; see below), picking up
the job and task from the
broadcast or insertion order.

■  In C&P Pro, imported vendor
invoices will be handled as a
media accruals if that option is
enabled.

Awaiting import. The media_buys folder stores
newly-exported text files from your media
buying system. The C&P Media Link can
automatically look inside it for new text file,
importing what it finds into your Clients &
Profits database. The file’s extension (which
may not appear if your PC is set to hide them)
identifies whether the text file is a broadcast
order (i.e., .TBY), a print insertion order (e.g.,
PBY), or a vendor media invoice (e.g., .VAP).
Once an export file is imported, the Media Links
moves it in the imported_buys folder.

Your media buying system will save
export files for each order or
invoice in the media_buys “drop”
folder on your file server. It should
be inside the same folder that
contains your Clients & Profits
database on your file server.

Once you’ve found and opened the
media_buys folder, you’ll see a list
of newly-exported media text files
that are ready for importing. (Once
the text file is imported, it will be
moved into the the “imported_
buys” folder as a backup.).

■  Only one media order or invoice
can be imported at one time. To
import many buys at once, you’ll
need to use the “automatic
import” feature (see the next
page).
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2.  Select the media text
file you wish to import.

Any text file in the “media_buys”
folder can be selected. (The order
in which files are imported isn’t
imported.) The Media Link then
checks the text file’s extension
(either .TBY, .PBY, or .VAP) which
determines whether the text file is
a broadcast order (i.e., .TBY), a
print insertion order (i.e., .PBY),
or a vendor invoice (i.e., .VAP).
This extension determines how the
text file will be handled.

■  Media text files can only be
imported from the media_buys
folder. If you try selecting a media
text file from another location,
you’ll get an error.

As the media buy is processed, the
C&P Media Link shows you how
many buy lines are being imported.
When the media buy is completely
imported, a log entry is created,
the text file is moved into the
“media_buys” folder, and an OK
message appears telling you that
the order was imported success-
fully. (If enabled, a log entry is
saved automatically.)

This step can be repeated now for
any remaining new media buys.
Once all of the media buys are
imported, it’s a good idea to check
them in Clients & Profits.

3.  Check the imported
media order in Clients &
Profits.

Imported media buys are saved as
broadcast or insertion orders in the
Purchase Orders data file (vendor
invoices are saved as unposted A/P
payables). They appear just as if
you’d entered them yourself from
the printed media order. Once
imported, they can be billed like
any other media order.

You can easily check the imported
buys by comparing them to the
orders printed from the media
buying systems. To see the
imported order in Clients & Profits:

1  Choose File > Open Clients &
Profits.

2  Double-click on your Clients &
Profits application when prompted.

3  Enter your initials and password
into the Introduce Yourself
window, then click OK.

4  Choose Accounting > Purchase
Orders.

If the imported media was the
last-added order, it will appear
automatically. If not, click the
Previous button until it displays.

Every line of the printed order
should appear on the imported
order. Be sure to check that client,
vendor, job, and task, as well as
the total number of spots and the
total cost are identical. If not,
delete the imported order, re-
export the media order from the
buying system, then import it
again using the Media Link.

Later, the media vendor’s invoice
will be reconciled with the media
order in Accounts Payable. By
adding the media invoices, Clients
& Profits will track how many spots
actually ran for each buy line.

To start the automatic
import

1  Click the  (i.e., Start)
button, or choose Media Link >
Start Automatic Import.

The current status field will
change to “waiting for the next
scheduled import.” This means the
Media Link is ready for the next
automatic import. The import
interval indicates how often the
Media Link will check for new
media buys; it can be changed
in Preferences to happen more
frequently or less often.

Once the automatic import has
started, it will run unattended
until it is stopped.

■  To prevent the Media Link
from interfering with the nightly
backup, it will automatically quit
at 10 PM.

■  If the Media Link is set to
always automatically import in
Preferences, any new media files
will be imported immediately
whenever the Media Link
application is started.

To stop the automatic
import

1  Click the  (i.e., Stop)

button, or choose Media Link >
Stop Automatic Import.

Any new media buys exported by
the buying system will sit in the
C&P folder until the automatic
import is started again.

The automatic importing can
be started and stopped any number
of times without affecting the
database.

■  Choosing Media Link > Stop
Automatic Import is temporary—it
doesn’t disable the “always import”
option in Preferences. The next
time the Media Link application is
started, it will automatically
import media files at the specified
interval.
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Printing Media Reports

Clients & Profits Pro prints five kinds of media reports: status, traffic, post-
buy, client spending, and group performance. Status reports are used by
media buyers and the media department to track open media plans, media
estimates, media deadlines, and unbilled media. Traffic reports allow you
to see the scheduled buys based on space closing and materials due dates,
which are entered for each line item on a media plan or estimate. Post-buy
reports are used by media buyers to see in detail the media buys that were
ordered on broadcast and
insertion orders. Post-buy
reports can subtotal media
buys by client or station/
publication. Client spending
reports are used by account
service to show clients how
and where their advertising
budget has been spent.
Finally, the agency’s
management can use group
performance reports to
analyze how well the media
department is managing
themselves.

Vendors and media
reports

Many client spending and
group performance reports
compare media buys by the
different kinds of media,
including broadcast TV, cable
TV, radio, newspaper, magazine,
interactive, outdoor, and a miscell-
aneous kind labeled “other.” For
these reports to sort media buys
correctly, it’s important that each
media vendor is accurately categor-
ized by the kind of media they offer.
This “media kind” setting is entered
for each vendor in the Vendor Info
window. Media buys for vendors with-
out a media kind setting will be
included in the “other” totals.

Media goals and media reports

The Media Group Performance - Trend Analysis report compares actual media
spending for each kind of media (e.g., broadcast TV, radio, etc.) with the
media department’s billing goals. For these reports to work properly, the
shop’s billing goals for each media kind must be entered in the Media Goals
window. Media billing goals, which are based on gross amounts on

Printing Media Reports

broadcast and print insertion orders, can be entered for each quarter of the
calendar year. For more information about media goals, see page 55.

To print media reports

1  Chose Accounting > Media Plans (Media Estimates).

2  Click the  (i.e.,

Print Reports) button or
choose File > Print Media
Reports.

Media reports are grouped
together by category
(i.e., Status, Traffic, Post-
Buy, etc.). Each category
has a collection of media
reports that can be
printed. Only one report
can be printed at a time.

3  Select a report
category to show the
reports that can be
printed.

4  Choose a report by
clicking on a report
name.

5 Enter a range of dates and select any available options.

Status and traffic reports are based on media plans and media estimates, so
the date range entered will select plans or estimates based on the date they
were added. Post-buy, client spending, and group performance reports are
based on media buys from broadcast orders and insertion orders. These
reports will select media buys from the broadcast or insertion order’s order
date.

6  Click Print.

■  Any print or broadcast media plan that is marked as “closed” or
“inactive” will not be included on media status reports or media traffic
reports.

Media reports help different
departments manage clients.  Status
and traffic reports track the day-to-day
media plans and estimates. Post-buy
reports help media buys track what’s
been ordered. Account service can use
client spending reports to analyze each
client’s media spending. Group
performance reports summarize how well
the media department manages spending
trends, client media profitability, and
spending volumes.
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Media Reports

Media Reports

Media Estimate List

Media Estimate Status Report

Unbilled Media

Client Media Calendar

Space Closings

Material Due

Media Job List

Media Recap

Discrepancy

Reconciliation

Mix Analysis

Market Analysis (TV/Radio)

Product Analysis (TV/Radio)

The Media Estimate List lists all media estimates for a range of dates.

The Media Estimate Status Report lists open media estimates sorted by status, which is user-
defined.

The Unbilled Media Report lists all insertion orders and broadcast orders that have not been billed
to the client. The orders are grouped by client and sorted by order number.

The Client Media Calendar lists media buys by billing period, which is based on your accounting
periods. Media buys are grouped by client, then subtotaled by month. The month’s media buys are
then sorted by close date and issue date. Each media buy shows its publication, issue date, ad
name, ad size, space closing date, and materials due date.

The Space Closings report lists the selected space closing dates of media estimate buys, sorted by
media buyer and date.

The Materials Due report lists the selected material due dates of media estimate buys, sorted by
media buyer and date.

The Media Job List shows the job number, job name, AE, job due date, status, and status note for
each job with a media estimate, and sorts it by client.

The Media Recap lists buys for a selected date range and sorts them by client or pub/station and
month. The report is based on insertion and broadcast orders. Included is the issue/flight date,
publication/station, ad size/program, ad name, net amount, order number, and the A/R invoice
number the IO or BO is billed on. It can be printed by client or pub/station.

The Discprepancy report lists any insertion or broadcast order discrepancies between the gross and
net amounts ordered vs. the actual gross and net amounts invoiced by the publication or station.
The report includes each buy’s A/P number and A/P date. It can be printed by client or pub/station.

The Reconciliation report compares an insertion order or broadcast order’s gross and net amounts
ordered vs. the actual gross and net amounts invoiced by the publication or station. It includes the
A/R invoice number the IO or BO was billed on and whether a client payment is posted, and the A/P
invoice number the IO or BO was applied to and whether a vendor payment is posted. It can be
printed by client or pub/station.

The Mix Analysis report compares total spending with quarterly totals for each kind of media for all
clients and all stations/publications.

The Market Analysis report compares TV/radio spending by quarter for each market (which is
optionally entered on each broadcast order or insertion order)

The Product Analysis report compares TV/radio spending by quarter for each product, using the user-
defined “product” field on broadcast and insertion orders.

continued on the next page

Status Reports

Traffic Reports

Post-Buy Reports

Client Spending Reports
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Media Reports (con’t)

Station/Publication Analysis

Division Analysis

Monthly Media Analysis

Trend Analysis

Client Profitability

Commissions Analysis

Buyer Analysis

Media Vendor Volume Analysis

The Station/Publication Analysis report summarizes media spending by client by quarter for each
station or publication.

The Division Analysis report summarizes media spending for each division and its clients. It helps
account service track the total spending for corporate clients that have many business units or
groups.

The Monthly Media Analysis report summarizes total media spending for each month of the
calendar year for each station/publication. This report helps media buyers and account supervisors
analyze which stations and publications are getting the most media dollars from the agency.

The Trend Analysis report compares quarterly media spending vs. the media department’s spending
goals. It shows how the shop’s media spending is changing from the beginning of the year.

The Client Profitability analyzes media billings, cost, gross profit, and average commission for each
client’s media spending. The report is based on the gross and net amounts from the client’s
broadcast orders and insertion orders.

The Commission Analysis report analyzes commissions generated by each different type of media
(e.g., broadcast TV, radio, newspaper, etc.) for each client. It calculates the commission based on
the order’s total gross and total net. NOTE: The commission is not calculated on the actual net cost
from the vendor’s A/P invoice or the gross amounts from the client’s A/R media invoice.

The Buyer Analysis report summarizes each media buyer’s billings, costs, and commissions for each
client. The year’s totals are compared to last year’s to highlight any improvements (or decreases).
The report also calculates the average commission for each media buyer. NOTE:  These totals are
based on broadcast orders and insertion orders, and not calculated on the actual billings from A/R or
actual costs from A/P. This report can be useful to agency management to help measure the
performance of each media buyer.

The Media Vendor Volume Analysis report summarizes gross and net totals, as well as calculating
the average commission, for each different kind of media. Totals are shown for each station or
publication for broadcast TV, radio, cable TV, interactive, etc. The report calculates the percentage
increase/decrease in billings for each station/publication.

Client Spending Reports (con’t)

Group Performance Reports (con’t)
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Feature

Imports media orders from SmartPlus, Strata, TAPSCAN, etc.

Media calendar w/e-mail reminders

Publications/Ad Sizes table for lookups on plans, estimates, and orders

Stations/publicatios table for lookups on plans, estimates, and orders

Broadcast (i.e., TV/Cable/Radio) ordering

Broadcast (i.e., TV/Cable/Radio) media planning

Broadcast worksheets

Print (i.e., Newspaper/Magazine/Interactive/Outdoor) ordering

Print (i.e., Newspaper/Magazine/Interactive/Outdoor) planning

Media estimating w/automatic ordering

Media goal planning and tracking

Media traffic

Media reconciliation (i.e., order matching with vendor media invoices)

Make goods for insertion orders, broadcast orders

Automatic WIP accrual entries for media costs and billings

Media billing (including pre-billing)

Option to bill net amounts instead of gross amounts

Option to bill commission only
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